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1.1

faifr

A

A #4418 F MPLAB® ICD 4 764 EiR S8 T 5 2 T MR — (S L

AIErFEEARLE
TR A SRS L) 5 «
F 11, CRgE
Arial FAk:
FRELNE ZE4H MPLAB® IDE User's Guide
i R PR S AR
EEAUYNG] =W Output & [
FHEHE Settings X iHHE
SHIEPE #%#% Enable Programmer
51 H 7 Bl TEAE A 0 B “Save project before build”
WHRIESAH PRIZRRME T SRR File>Save
Hlf X EAE F i OK
T E #; Power &5 K
N'Rnnnn verilog #M% =z, HH N 4%k, | 4'b0010, 2'hF1
R ML, n h3Lh—4,
R T < >HHE I LF ST b % F<Enter>, <F1>
Courier New -/
# #i Courier New TEARS 7~ 451 #define START
A4 autoexec.bat
AFERAR c:\mccl8\h
KT _asm, endasm, static
AT IR -Opa+, -Opa-
hbei LAl 0fl1
W 0xFF, ‘A’
#HA Courier New AR file.o, FH £ile A LLRATATA R
A4
kRN kS mccl8 [options] file [options]
TEFE SRR (]} EEEFSH B g errorlevel {0]1}
B ... REELF var _name [, var_ name...]
o i P R AR x{zoid main (void)
}
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1.2

AP FEFENA T Wi 4 MPLAB ICD 4 fE£8 /i35 . T oA 7 HARE HASCRY . LR Microchip SCRY I B 54,
IHEB I VE NI TS H R

Z T H#EHE% (DS51764C_CN)

TESE A SR | AR AL 8 S fEAE ] MPLAB ICD 4 7848 R 28 34T H bR st it ik B 2 h& (4 V8 ) ) B 245 L.
MPLAB X IDE 724235

X R AE{# FAEAT Microchip B84 T B [ & 30k .

IX/& MPLAB X IDE AT, BEBHRARKAMMIR . 22ER, BREULCEFTH. WERFRE. 7
RAAD . WEBCEA . B BS U RS H IS B . 35 B SO @ # L AT BLAL www.microchip.com/
mplabx/% %% N3 S 4Em (DS50002027) ) PDF 2 E #i.

MPLAB ICD 4 7E£&1H A28 I R AT 4

XA H MPLAB ICD 4 7E£ iR 2% s B, 15 %% MPLAB X IDE Start Page (#2457) I “Release Notes and
Support Documentation”  CRATULIARISZRESCR) TRIULIH. RAT U AR P e T RSt E S
H1 i

MPLAB® ICD 4 HuE A J$EFEAA TR (DS50002538A_CN)
AL AT AT g B AR AEEAS A E FRHCN MPLAB ICD 4 7828818 2% B g A 22 S 3501k
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2,

21

2.2

KT HERAR

KT AR

4Rt T MPLAB® ICD 4 76248 it 52 R S kA .

MPLAB ICD 4 7E £k /iR 58 Ui BH

MPLAB ICD 4 7E£5iX#% (DV164045) /& Microchip st H 45 @AW gafE TR, &M T Microchip
PIC®. dsPIC®N{#41 CEC (3T ARM® Cortex®-M7) HHEHL (MCU) . Z i LLRERSHOE MM HEAT B . FEATAR,
HELET SAME70 MCU (32 fif MCU, 300 MHz, 2 MB RAM) #ilEi# FPGA Hibns. f 5Ihksm Kk HINAE 5 T1EH
B IE F P 40 Y MPLAB X $E AT &% 3135 (Integrated Development Environment, IDE) &8, #4704
2. MPLAB ICD 4 it i USB 2.0 82 MERRTHHNL, JHdit RI-11 EEEEE: 2] B A5tk . MPLAB ICD 4 A7 {ii
F JTAG #1.

HFZ AR R G E N B E BB ARE (UEERRR ARG R, IR M HAT 52 bR s Ml it i%
PRES KRG AT LAA2 B 7 7 45 2 2 A I BB T R Bhig, HATi@id MPLAB X IDE JFiiHi s B A& X L T e .

MPLAB ICD 4 L ARSI AU TERE T &

Microsoft Windows® 7 &l 5 F i A
Linux®
macOS®
MPLAB ICD 4 e i i#8 T AT AN R HE B A &, BAFE R IIEE, A SUGESRAE LT T TH5E% 24
AHESAH T ANFE
o AbPRER DU KR EIEAT
o AEMEEERR /O I BRI
EHENEERED (Windows. macOS F1 Linux)
OB N AT
YRR [R] B AE
BT Crrdila A my g D
B 7R TIRESS, MPLAB ICD 4 7E£8 iR 28 R th vl FE SR A r= e s o

MPLAB ICD 4 748 AR B KL H
MPLAB ICD 4 7E28 1% R G HA LA T

4T RE -

 iEidmE USB 2.0 (480 Mbps) £R455&E4: 311 5ML.
B bRV ) Microchip JHRERERS (RJ-11) , FFATEBFREH JTAG.
{# /1 MPLAB X IDE 8 MPLAB IPE %ifs#$4F

o KRR AW HRAEA SR

o R E TR LS RN R

o BT AIHEFRER N
SN ST P AP
SR
Jie & 51 SR B 38 .
Al MPLAB X IDE [ Rt T Iin F+ 44 .

o AR EFIRAR MPLAB X IDE (A] A www.microchip.com/mplabx/% 2 T &) ¥R INHTH 284 S F A Th g
¥ LED (3.
ALFE AT LR BT A 0 R
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KT HE AR

A7 0-70°C MR EVE N TAE.

PEREIE
o VRREEE . P EHRIGEE RS
SHEVE RS (Real-Time Operating System, RTOS) .
B AR A I AN 2 A T R AR
+ 1E 300 MHz $li% Tig47 1 32 2 MCU.
* 2 MB Zrfifds.

24k,
o HEFMRTEEMSBEIRR, MRS Bl

o W 1.2V E 5.5V I H IR,

« EHTEIER 9V DC HLIESEIUR B 1A B i,

o FESRETIRBNER ARG LS, DAME 2ok B H PR IR N fE S

* Vpp F Vpp i WAL 48 it R R BT 2R i 3 B i R

o TEME RN ER:, AT FEART A Chdr, BT LA, MERVERS Y LRREN.
AR AR SR T R AR PE, ARSI HARAREL T I R
¥4 CE #l RoHS #rift—— & 1T Mk brife .

23  MPLAB ICD 4 7EZ iR s 1
MPLAB ICD 4 £k /i #% R A A1 EL4E:

— AR AT P S 0 /M FE BRI MPLAB ICD 4 %45, Tt LED #8744 . Mini-B USB #4253 . RJ-45 482 H11
RS (9V DC +/-5%, 0 NIERR, 2.5 mm J12/5.5 mm M) .

* Mini-B USB £k45, HTHEALRAEE 5 1B [AIAIEAE DA TSR a8 L .

© 6 TTRIHULZRLS (6 51 RJ-11 8, FTK MPLAB ICD 4 1% % B3] H ¥Rt -

« AT AR ICD MR E B (AC164113)
B 2-1. BERRABRSA

Mini-B USB Cable

ICD Test Interface Module
Modular Cable

ACTEATNS
shppmnbly F:

- B3R

Ho AR AN B4 7 LA Microchip BEL&4 M3 (www.microchipdirect.com) BT I,
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KT HE AR

© REAANERC AR GBS AC102015) —— 3K 3CHF JTAG. SWD AT ICSP Wl MR, &M T H
MPLAB ICD 4 {14t AVR®H. K Hl (www.microchipdirect.com/product/search/al/AC102015) .
« OV HHIE GBIE4S AC002014) , 110-220V i@ FH HYE, Jy Hbs R = 1A BRI
(www.microchipdirect.com/product/search/all/AC002014) .

24 MPLAB ICD 4 {£&

S5 | wens

TEMP
SENSE

SYSTEM
IDENTIFIERS

9V EXT PS

(®)

O—{(1C SOFT U Re
staRT  LREG

+5v RGB
PWR | +3.3V (12C)

DIST | +28v CONTROLLER

+1.8V STATUS

+1.2V
+9V_INT ..'..

SYSTEM TARGET

TIMEBASE
(10 Mhz)

CFG
FLASH

LOGIC
BUFFER

VPP
GEN

VDD
GEN

1/0 CONFIG

PULL-UPS ICSP RJ-45

PULL-DOWNS
HV DETECTION _§

DC ISOLATION
VDD SOFT START
CURRENT SENSE
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3.1

TR

TARRE

AREREMIR T MPLAB ICD 4 £ R M TIEEE ., BERMEWHES, MO RS E 0 iz
W, CAHEAT AR AR AT . ARSI 18 T ELR MG R RO R A B, DUE ] P REAS DRI i i D I8 B F ) L

RS B ARRZ R @S

HE. 5% MPLAB ICD 4 /2R 2S 2 10, 414525 MPLAB X IDE # 4.

P IEE L USB e 0E I N, DL T A RO S At Gl HARiR gt .

VIR EIE B H bR A LT IR E AR . ARSIATERER, S0 9.3.1. K RI-11 BUZRL 32 21 ulas
1 RJ-45 4 fL.

R I8 (RAONE L) RS HARNA CEIETHE) s ulas m AR At .
AR TR R AL E

=5
%

CAUTION

Communication Failure.
Do not connect the hardware before installing the software and
USB drivers.

CAUTION

Debugger or Target Damage.
Do not change hardware connections while the debugger or target
is powered.
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TR

3.1.1 FRUE ICSP 244815

VEE: MPLAB ICD 4 A3k,

R I g R GG E VA ARYE 6 51 ICSP (BEB AL S0 AR EHRSAT IMAE A RIK T e . BB LR T A H AR
W RIBCE SR, B H AR B AR L E (L RED .

ARIFEEEREZEL, SN 9.3.2. brdEilfE,
B 3-1. iR R G —HA A L ICE rUBRII#4+

External Power supplied to either target or debugger.

. Ta

Device with on-board ICE circuitry

<
E =

Target Device

Target Board

3.2  HintEFEESE
321 REEE HARRER

BEE: GXREZHEEME, 1S WA SFREE T DURCR € 3 D N 2 .
T R SRS, @B (605 454 MPLAB ICD 4 7EZR IR 25 #: 3 HARSF. R385 g 5 2
ANE H bR PCB HIJEHS, R E PR,

BHE. ISR H AR LIRS B oG, BN A5 1 SRR S g 6. iES
9.3.3.3. HRHLILLELE ML
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3.2.2

3.23

3.2.31

AR

Bl 3-2. BiniR L RIbREEE

Target
Connector

00 0—
/1 3\’5
Bottom Side

AR I L
TEEIR 7 MPLAB ICD 4 fE£0 K #4515 H AR B SS I EIE . ZEIERoR T AERS S| H br PCB L3 FHIIEL .
EWAE Vpp/MCLR Zi Al Vpp Z A —> B GEW L8 10 kQ) , PUEREZ @ I s LR AL g AT

3-3. 5 Hin B I bR R

VoD
Device
VepMCLR
PGC
PGD
Vss

AVDD

Interface
Connector

H it
A PRI AT AR H AR LA

« 3.2.3.1. B HERRMAMT AL
o 3.2.3.2. LA EE WAL

TETRHPIULE T, A IRE S RS BB S AR A 2(Zk: 511 (Vpp/MCLR) 5l 5 (PGC) A5 i 4
(PGD) . E3-3 T E/RTEIM2 (Vpp) MBS (Vgg) M Tt EE,

NIRRT, R B bRas A S R EE e T st Vop BUEERHIE T

AT A Vpp A e K fE . SR E iR KAUE AR T TAR— B Ia],  HnTSedk nl ge sz 21520
FATE VA ZAE AT TAR AR I S 2R T AR R S EOE R 21 T

AT R it (R s HL S RN R K AIUE EL, 16 2 WA 00 T

I B AR SR e

N H RSO R RE T iR A S B IR B ROE R B AR . BB, A4S I H AR Vpp BLHEAT BT B4R sk
PLEARCHR SR . R AR AE I Vpp 28 GBS 2) FoRIZIE I, ek ek TR,
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3.2.3.2

3.3

3.4

AR

ISR A EBAL
B bR st e ) 5 —Fh 5 R A e R B 5% E R MPLAB ICD 4. 157, @@t MPLAB X IDE & i
MPLAB ICD 4 23t e,

FEARA BT AVpp M AVss £k, EZ IR AR EAIXMIRE, O TS RENS 1L TAF, AU e g
LK. BN T B ERE.

EEREOLT, B ATE Vpp/AVpp Fl Vss/AVss LRIEREIE M, Bbah, REA Veoap L2 (BN
PIC18FXXJ MCU) HEHz2I3&E X4 i s A sl HLF o

e MEERARF R . T IB B R R, AR X e LG E T MPLAB ICD 4 fE261H ilds RSt )
b fe sl oo SRR, A

R IE 83 28 1E AR R B %
TEZH T RS =ARA &Lk 2Bk MPLAB ICD 4 72kt 8s 240 1E % TAEM — 204,

Bl 3-4. AN IERHH B LR

VPP/MCLR 1
No!
No!
No!

PGC H(:5

PGD =
Interface
No! Connector

BUIHYE, 2B A LA HE .

* 1211 PGC/PGD LA il Edi——"e 1A RE SR AL

© HZTE PGC/PGD A Fl BZ8 ——BX AT THe FHL b 25008 20 0 B 4 2 76 A A0 18201 15 IR PR30 HL 25 S K R PR T
1] .

* 1EZ)4E MCLR AR A ——"EA TR LE Vep PRIEAR (b 35— 00 Lhr Bt C A2 %

* WH2)4E PGC/PGD LA A ——"E A PR BELLE R i85 A0 A 4R 2 1) HEAT X1 38 45

PR

ff F§ MPLAB ICD 4 726 iA 8 RAMENRIRIB AR AL IR B PRGN AR RS B H bR rh Al
MPLAB ICD 4 SRi#17) o 28 25 2 AF F B AR INAZ 244 0 P R 7E 2 AR SR A7 AR B AR P . IX 25 5 MPLAB
X IDE #:1E HH:AH K

1. CBAREGEES B H PRSI RS BRI R IIRE CHGEIE R, WS LTI .
2. AR E W BT

W AXEZELR, B2 MPLAB X IDE 7EZ B .

W HARa A BEYE IEFI R FE, MPLAB ICD 4 2L ARSI LB T R

N4 1T MPLAB ICD 4 7825 188 130 2 P 3582 1 BB O i AL P
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3.5

3.5.1

TARR

& 3-5. IEHi I ICSP mfsiti

Programming DD
*oltage
40 s a 1
= Internal Circuits &
-- 4

:
;

GRREHT, EARAR IR TR b, (HASUN ARG AR, SnfR, JHRAETE Vep/MCLR Lt hngi EEE 1_1_ PGC &
B KaR, G PGD RIEHRATESE . BRI SR T CHIETIgAE, ATELR PGC AARS B, JRili PGD [ ¥
o BEARAF AT BN A 5 S AF 2 (A2 75 IEWRIE (S

WIRE K
ZL§ ] MPLAB ICD 4 7E£R iR 3 RGUHAT R (RBB S MBS HFEHRS) , UTFERELTIER:
WK R AR E BT N B L AUEE USB Z4id i EAEE, I B ZtdEid USB 2405 MPLAB X IDE #
P15 . ES AR “Getting Started with MPLAB X IDE” ) MPLAB X IDE #B3Cft:, 57 “Tutorial” (#
) 8475 “Running and Debugging Code” G&ATFIFRAIT)
Hbras U8 B B B ERIB TR 2. W B bR as AFRAT AT R K JEi252 1T, MPLAB ICD 4 7EZE A4 0
VEAT IR
DAUIERGFE B bR 2SO EC B 7. XU B 7 MPLAB X IDE Ri%H.
- YR ARAC B A NN T RC A XT 2%, EARE T B ARt
TR, B e RSB RE, TEEARIL.
ANEASRE H bR a4 ARRD G Th g
ANEASRE H AR g 1 R SR T BE
- W TEAZA PGC/PGD 5| %t fIFE e384, 7 ZAEA 4 1IRC BE 71 B IR B EH 1 51 X o X — s
PR, EAgRFE BT PGC/PGD 5| %t T1E.
R T LR, BV AT N AR

3.5.1. A TH IR MR 1E 5
- 352, I A

BEANR R RAE 51
e 3.5, WIKER, K MPLAB ICD 4 7E£8 i 2% % & MPLAB X IDE 1 {) 2477 L H. % File > Project
Properties (A > WH @M , FTIFXHENE, SR/G7E “Hardware Tool” (A#ifET.B) N ICD 4. LA AT LLIAT
DU A
1% Debug > Debug Main Project G > WRTIH ) B, NHFEFAILEET ICSP Pl g fe ) 28 1 1 16k
W, WAREI KR

© 2019-2022 Microchip Technology Inc. FFars DS50002596F CN-3f 13 1
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3.5.2

3.6

TR

AN CTERPATRER” BN E] B AR AR AE R . BT R R R SR R BT R A A S TR RE T A i
A, R AR AR AR E S, BRSSP RPUTREFIRE T EIIMAMEX . BREAEERE, &
Z: DA B T
H AR A rp Bk “TELRIR” 27 8%E e MPLAB X IDE ffifE. iXLe2i 4728 R s isom i T ie % . A
KA RERTELZ/EE, SN MPLAB X IDE Help > Tool Help Contents > Hardware Tool Reference Help
(Reserved Resources) (#B) > TA#EHNE > B TASHEHD (REEE) .

© HARSSAHE RN IET

WRAFEHEER
T EER T HERIFIT A6 MPLAB ICD 4 7E20 X 4% R 4t .
Al 3-6. AT FFEARIN MPLAB® ICD 4 74358

Program

Registers

TR I RE P RE S IE RIS AT, W W AERE PP AU P UG B BT . il MPLAB X IDE F 1 J i e B W7 it 7
SRR LR H ARSI R R A E A2 2 b . PGC #1 PGD Ly iy 4 BLHA% 1% 31X Lo 35 A7 30K 15 B T mi bk

BTk, @7 MPLAB X IDE Hi%$% Debug > Debug Main Project Tift. SRJ5, TR Ie@MIARPITIEFEZET. B
Fres ks NEA M EFFEHAT, BEEIFE R T A0S BIIE S A A7 64 70 P9 38 R 25 A7 2% P FO W7 s

PATW bbb 484 )G, BRReEaE LBl AIE S “Bsh” . IFERERRE LIS A AR PATREF (L
T, AP RNHEREEERIT. il PGC M PGD SHRHUTRFEE, KB ARSER, kX
(s B K% MPLAB X IDE. Bfif5, MPLAB X IDE [mi#iR#s K% — RIIEH, USSR T HiRSHHER, flunse
T F RN A CPU IR . X sy iR BT FEF $ AT .

TRPAT R BTG 8 P N AR —FREAT . B AR St e bbbk B A g IR AR B, RS 18
17, T FMMER (ARG BIEEENER B AR ERS , HRAPUTFEF &% L7k 5 MPLAB ICD 4 7E4k
PR EIE(E, FFH MPLAB X IDE ¥4 %%t — AR 2 .

BEE W5 1 53 —Fh v 2 1% B Debug > Pause (IR > #15) . X&#i%E PGC Al PGD 2k, MT# B xS i 7E 281
ML FE P T a8 W P A7 f s h 1 F P ARG D1 2R BT FE . FIRE, BN AR 1%, MPLAB X IDE it
PR SR IRBATIE P B (S R B0 H RS RS .

gfs

. BXRHEMGEE, 120 MPLAB X IDE 7E28#5 1,

VEE: MPLAB ICD 4 A3cE k.
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3.7

TARR

£ MPLAB X IDE #, f#H] MPLAB ICD 4 {E A2 a3 k4ufedE-ICE/-ICD #54, BIATE R LR L. % MPLAB
ICD 4 7EZZ 3 ¥ B 24T T B (AT 541 % D Debug Tool ICD 4 GER T H ICD 4) , H&E MLk
File > Project Properties, ¥THFX11EHE, 2R/57E “Hardware Tool” T H.i; ICD 4) DIPATIX S

* 1&# Run > Run Main Project (i&17 > izAT7EWH) ks (WHED J5, MA@ ICSP Hhilgufe]
AR T AR AT B, AT DR AR A AL BE A, CARACRD ARG (AR 1A I R B £
.

& 3-7. Run Main Project B3

P%-% Q0

Run Main Project

o KT REERARESE, LU AN CORREPATRERR 7 AR B RE A & 0 Rk DXk
FUARasPE i AORE IR “AELRR” A7 as UL AR T gy iiid MPLAB X IDE 251E. IXEWRAE AN RE B BT,
AREEE BE A A N A

o HARSSFISATER AN . AE v feds, i R aEIE @ MCLR ek = ALANSE 3 H AR as 1t

a5 IR
BB TR B BT R RN 5K, 152 M MPLAB X IDE #1752 MPLAB ICD 4 fE 45 R SeffE e 5 Bh stk . 78

MPLAB X IDE ¥] “Learn & Discover” (Z=>JF1KI) i+, .5 Users Guide & Release Notes (H| Ff5RiHlIk
789 , A58 “Reserved Resources for Device Family and Tool”  (Cly#$ft: R 510 T B4R B ISR e,
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4.1

4.2

43

IRAE

A H

DLF S SRR T o] 2235 A48 MPLAB ICD 4 7E4 it 28 ({5 2.,

ZEME

K23 IDE i B IHAER LS IDE Bl &AM H4E R, ES 0N “Getting Started with MPLAB X IDE” 7E£k 3 B 5C
£,

TR :

1. %% MPLAB X IDE.

#™: MPLAB X IDE fE£RFE R4t 780 T8, T M\ FE X H A Help > Tool Help Contents >
MPLAB X IDE Help >Tutorial (¥gh > T HIEEIP% > MPLAB X IDE 8 > ZF2) )X 3=
i,

2. 4 MPLAB ICD 4 A FTHENIF R VF 230N USB WahfEF. AR HBBOERNEZEE, 20 3. TR
Bl

HE: HRABIE N ARGt BN, S0 4.6.2. Ny HARRALE.

3. EFBHFREMHMIES TEAEMRFES, B LBEETEN L.

4. J2Z) MPLAB X IDE 4T F1E4k#5) (Help > Tool Help Contents > MPLAB X IDE Help >Tutorial (338> T.H
FEHA 2 > MPLAB X IDE il > #A8) O, VSKHCE AR v BT 0 H LIS AT AR ARRD I VR4 3 B .

FERED:
1. BMEREEO S —AMME—PRIRRT, BN, TR AW TS USB i 11 #2 BRAE R S0R 5.
2. MPLAB X IDE fEig{T G2 TEfiialT) MiEsRmi TR, BEn4aE8 8 TR, 1#lik# Tools > Options
(THE >%&BD $ Embedded (CL%%& TR 4, #R/57E Generic Settings GEAWE) EH-RHiEH

“Maintain active connection to hardware tool” ({35 5804: T B [\IE 0% ik,

3. EENLHBETE Configuration Bits (FLE A1) &R ER . BEEAGHREREN, EH Window > Target
Memory Views (% > HFrEMARMED , )5 M Memory (FHif#) THiglRhikdE “Configuration
Bits” , M Format (#30) TFiudl& Fik “Read/Write” (/5 EREN ¥ & KII il .

WIREE
HEZ AR “Getting Started with MPLAB X IDE” f#] MPLAB X IDE #BI3C#F, IR “Tutorial” 1 S %]
“Running and Debugging Code” #5%) .

AR RE S %
L T A5 MPLAB ICD 4 {5 £G 1R 2 A 1F T i i P2 TR (0 et 2%
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44

4.5

IRAE

R 41. BREHEERE

T T A THENLF H AR (Microchip HRHREE B St HERRD -

WIKA . USB &AIRIHIE (RFHFE) .

i b R B RS e OGN w7 Y DI
;APLAB XIDE # | Project Properties, Hardware Tool %% ICD 4
25

Make and Program Device (%% 31 4ifeas

Debug Main Project El¥7. _ %,, -
) BEr

G fEiRAE BN R AR S IS XA LGRREY BN RS RE S B A . XA DGR AR
AR AT, BARBURT Project et AT, BARHUR T Project

Properties X} {5HE_F kS, Bbak, F —A/)N  Properties XHEHE - 1%EFE
IR PAT IR AL TR A 2 b, HoAh i

BHRIR B -
AR D R EH T AR A IR D fe—— B s 5E N/A
FE S udgmfE NA {8 MPLAB IPE “E R SQTP (.
(Serial Quick-

Time

Programming,

SQTP)

A AT HRAE i1 H MDB i A7 SERHFRT, BRINEEAEAN: {§i ] IPECMD, ERINEKAZN:
C:\Program Files (x86)\Microchip\ C:\Program Files (x86)\Microchip\

MPLABX\vx.xx\mplab platform MPLABX\<vx.xx\mplab platform

\bin\mdb.bat \mplab ipe\ipecmd.exe

1K 23 R 1

B RA IR R e 8 HIK, 20 MPLAB X IDE F17ELH B3 {4 (Help > Tool Help Contents > Hardware
Tool Reference Help > Limitations - Emulators and Debuggers (¥ > T BFEIINE > f#4E T ES W) > RE—
i EBMRES) .

HEB Bk
1. IERMRERE, 1A Mini-B USB ZR 45K 28 5 S &
2. HIBE RO RIS BARRAIE .
3. BHIRERE AR SRS
¥E: /&£ MPLAB X IDE #, #&AT DLk $E8 H brti gt i YR . Z2id i MPLAB ICD 4 i3 #5 8 H bRt ik, 4200
W IR BN

AXRELZVEMESAE, B2 W 3.4, IS HArbie (8 1.

© 2019-2022 Microchip Technology Inc. FFars DS50002596F CN-3f 17 1
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IRAHE

Bl 4-1. B8N HARR G

@ Mini-B USB

Sy

From Computer

Communications Cable
From Target

Target
[ I—=| Boarm

®

*Optionally, the Microchip power supply (AC002014) From Power Supply*
B 4-2. @ E AR A B AR AR

©

From Power Supply

@ Mini-B USB

Communications Cable
From Target

From Computer

Target
[ ——= Board

46  WEBMK
AL PR b 250 B b

461  fERAHMF
XEFAEPA AR, AT ORI S EEOE R R H . H ik B AgEsPF L Z0E N B RS, LUE MPLAB ICD 4 ££2k i

A EET R
HARR LA — A&, LLE G NS INEIEE T e ARERGEE, WS 31, a5 H stz 8 i
f&o

4.6.2 N ERR L
B AECE A9 MPLAB ICD 4 1 H Anbi it .
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4.7

4.8

49

491

IRAE

H AR i A B R AL e
H ¥t i@t MPLAB ICD 4 fitH, MPLAB ICD 4 &4 24M 55 ik .

AR GERgR 5 AC002014) WM Microchip EL48MIuIASE, MIEA: www.microchipdirect.com/product/
search/all/AC002014.

T AT 24 (2R 454 MPLAB ICD 4 JE8: 3 HARtR (WL 4.5. B EHAEO , Wl RBAT IRIE . 2R)5 N B babft
.

Ja BAME 1R R
VE: AXRERRTIEREKER, 20 MPLAB X IDE 7E26#5 B .

LA MPLAB X IDE Hif il B e, I — NSRS U H DB FZ R0 T i g A KA be s 21 &%
fErpIF AT

%P Debug > Debug Main Project Bi )\ Run (Gz47) T.EFLkE IAIE AT ARG

o=
- #%4F Debug > Pause S\ Debug (i) TEA . o Bl EH i,
o=y
« 4% Debug > Continue (i > 4k4%) M. Debug T Jk: it L N 1) i iz {7147

* &% Debug > Step Into (IR > A Bl Debug T HA=HiE# @ LS PATAES . JERAE RSN
Sleep 54, 75 NPT A2 38 52 A7 LA 52 B
* %% Debug > Step Over G > $0Bkid) M Debug T A4 HiEHFmbl #0 Bhid — 41748105 .

*+ 1%&#% Debug > Finish Debugger Session (IR > 5E A AR 218D BN Debug T B4~ ik 4% |:| DL AR B
7.

« %% Debug > Reset CiX > &) M Debug I/EJJEPJZ‘H%IU&TKE@%??&E@%&”EH MR a2 AN [
REA HAME AL (1 POR/BOR. MCLR MRS EN) » HREZEE, EHS W™ mEdEF.

BE AR S ASCF

MPLAB X IDE &4t 7 24 & MR & WG EFG#EEE R, 77 Window (& 1) SERFHTIES . AR ey
HWHOMELZER, 530 MPLAB X IDE £ ).

Window > Target Memory Views——2 & # 1 Eflde HH 0EE (BEAAiER) FRS (BT o HAL E 6%

P AT LR SRR SGHAT R, BN, BENA. CPU Z1E8%. 4N EBl 126 5%. 4P SQI 124k 23 A

ID ffif 2845

Window > Debugging (%11 > WiX) —AFHREL . WEE. W, MR, B, mRSPHErikiE.
EEEUY, 7F Projects (WH) & H R BIVFACHS SO0 d5 LATE Files (UMY & DT . 28 R AR AR

B T AL HE 28 A g P L ESR AR B bR . B B EARIRIEER, 7E Tools > Options ] Fonts & Colors (“Ff&kf
i) h, ¥k Syntax (i) &I,

W S A B R
P O o OO A7 B AR o P BLZE A E R0 (AT HEAT T o LR 4645 A A AR B 0 1
.

Wi R
XFF 16 frdsfh, Winis BlE RS T S AR R R B, DRI, T AR T S BR b TT R B A f A f
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4.9.2

493

IRAHE

XFF 32 frdsf, Wil BB S B PE RIS AT RSN R DRI, AT AT S T R A BT ok

a] A E S AR AR S BE Dashboard ({X3E4R)  (Window > Dashboard (&1 > X FIR) ) HHHFE
Re HRIZBEMEZER, ES 0 MPLAB X IDE ZE&F WS, IHAEFTA s #0E SRk A

B RWr s BRI RG] CELFREREA 280 A W 5 15 AR B LR RE AR I 05 i T S5 3E A2 (skidding) KN, iES L
MPLAB X IDE BUAELL T B 1 it o= iR 23 FR #1115 B _(Help > Help Contents > Hardware Tool Reference >
Limitations - Emulators and Debuggers (758 > 75BN 2 > BEfF T A% > [Rit)—— (7 HZ A ED ) o

TR BT U 3
SRR B AT

1. 1E Projects & L HFi& Wi H . SR)5, i&F File > Project Properties, %458 #0457 H 3£i% % Properties (/&
) .

2. fF Project Properties Xf1iiHE} (Categories (ZK5H]) F) , i%&#% ICD4.
3. 7t Option Categories GEIIZH]) T, L% Debug Options (LI .
4. % Use software breakpoints (i 4R £ ) LA B 300 7 o BSOS 30 v B0 m) {3 ) ARl A2 B i o

e (AT AT P S S SR RO I R PRI, SO BERE U e 7 s A A 8 R P AR 2 7 2
NS BT E S PRI . (REAF B, RO R AT s AR AT 1 EEA
R 4-2. BT R SR AEETS

etk A T AR L7 G 3 U

i i £ AR TR

LIYSREPNE PRI T A 2 IN A7 2 7 A7 fih 4

M P PR 7 AE Al 2 PO AP 25 AR PP A7 Al

BEHE W A I ) e R T R a L« AR N A7 A7 4 1
IS 18] LA TR/

Wrsilg# (skidding) | KZHHT. AXRFEMELR, ES WELTEHHH T
Limitations (PR#]) #B4> .

R VN PN A
EMT W RS DI RER . IR R E W R E

W xR LR A8 A
W R T AR B PRAT o L0 52 I T 2 TRT R IF 8), TE (H EER

H I E LB S RPER, 1520 MPLAB X IDE fE£: 35 8).
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BefRE

5. SEEMRE

% MPLAB ICD 4 7RIS E TAE IR B e, mldid DL & 13R85 8.

51 EHEEEG i

A5 F R R R a4 7

LECRERI A, B F 20 MPLAB X IDE FHR B EGH A .

AE A IR Microchip MBI RIS RS B CHTH BB ? BRTEME T H T B8R R/ R A HHEN ?
EHS . 3. TR,

BRBCHNBERRAEE?

WAZIURE MR F IR E AL B H AR CEa%) B Bles .

EREAERBEPMHEHT USB 4% B&ABC LH?

WERAA T, 355 Al SR 2 oRIE SR Wlas R RE BTSN S
BREMEA T HARS ERANIMERGELSE (RI-11E) 2

IR T AR, AT e BUEAE ER .

ERGHEMA T%ﬁﬁ%ﬁ;ﬁ%ﬁ#ﬁ@ USB £&4i?

oAt USB Ze4imT et 22 . i KA S RF USB JlfE

5.2 FTEARNEERRE

1.

IR

N

10.

1.
12.
13.

WHBRA L. MAESIRGHARLNAEENEE. WRFEANZINTIRG S, EER AN TR R
FAR AN PLL, ifHfR PLL 38 EH.

SR 7% S O R R o RL

Vpp BERIER. Vpp HIEEH ZS 4T, BEZHAEE, HS NS FREEMTT.

WiFFEE R AR A OS5 THEAURYE B bR G . A Al R AR .

WA WIS PC B[S TN . 76 MPLAB X IDE & 31 5 i85 .

BERLEERIN . SR IEF A BRR Fo SRR SER B IFH B iR i, (B fE Rk s
SN, WATReS I BILL T W E: Target Device ID (0x0) does not match expected Device ID (0x%x) ( H F5 s
1D (0x0) 5T ID (0x%x) AITED) , Hrh%x N ID.

BAEZEREAY. BMETEMRE, WIS E TR,

MARERFABHRE. HisNARFRRSESH R SR ERREMERRE BN AREF. R)E0 B Ak
T EHEEN.

RIRE| AR, GRS A EfgmFE PGC/PGD 3| ixt (iF#% 4 PGC/PGD 3| ist 2244 .
FEHIMORE. LR ERE TR ML B ARIAT RS f AL B 3 B R AR S B L7 BSOS B TR
.

RIEERNTER. REMIMEE KT TIERE Vpp. XERESRA T EA0RE, Aok,

BEBARTEM. 1HS 0 3. TAFFEIE A ) 7 #7 E 6 08 % .

ERER . RS RPATE R ERME. Bltn, R HEsN AR IEEET, MRS LR B S,

53  HREZBKHMIFR
5.3.1 — s

1.

{EH ICD Mt DA AR 28 2 B IE®H LI/E (9.4, ICD itz Ot

W, MAEATRES PR . (IR, |> KSR Ul s AT, AR5 ) F AR PEbE S — AN S AT B

2.
FRIN FHFRT (B0, fF LED (NMRRIFET) « WRFEFEAIEZET, WU B R B AR R
3. EARMERTREDNIIER R Cnd i ERBIR. FFRIEIH B S AR 1B R A B RRIR .
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BEMERRE

4. ﬁ%ﬁwﬁ%&&ﬁuﬁﬁﬂ%fhﬂﬂﬁﬁﬁﬁﬁ HAREZER, HSU 3. TR,

5. ARENEM R E TS EmIS®EE . /£ MPLAB X IDE &1, # % File > Project Properties, 1t Categories
EF'J‘@’% ICD4, #RJ5ikF Program Options (4mFE1ET) M Program Speed (4FEiE) , MAHR FHisk ik
B MR . BRINEE N Normal CGE#E)D , LR,
& 5-1. Program Speed %7

Categories: )
.o General Options for ICD4
----- @ File Inclusion/Exclusion Option categories: |Program Options x|
=5 < Conf: [default]
- 0 ICD4 Erase All Before Program
@ Loading LED Brightness Setting 5 -
~ @ Libraries - i 1
o Building PGC Configuration pull down v |
B @ XC16 (Global Options) PGC resistor value (kohms) 4.7
""" = xclb-as PGD Configuration  pull down v
2 xcl6-gee - I 1
o xc16-ld PGD resistor value (kohms) .4.?' .
e @ xcl6-ar Program Speed Normal R4

6. ERLELLT, WSS RELIR IR IBAT, AR E N A EE WA A . 155 IWBL TR o) BAE
HoAh At

53.2 A EEERK
4 MPLAB X IDE 5{ MPLAB IPE JGi% 5 R385 @15, WP AR5 ZEom b i a5k N F 2850 CR o R o —gkmr
R s R A R
* 531, — BB HIAER 1-5 WA IE AR A 2
* MPLAB X IDE 5 MPLAB IPE Joik 5 iR #@ (5 (941, LED 5 (LRI (L2 AR s A2 40D«
« %R Project Properties H'[f'] Tool pack selection ( T HALEE) &S5 T 1 Tool pack update options (T HAL

FUORETD FBRWEN “Use specific tool pack” (i F%fE THE) , {H MPLAB X IDE HHEESHITIRA . 1EiX
FEOLT, WHEE NN “Use latest installed tool pack (recommended).”  (fif & ¢35 10 T B AL (HE

#) ) .
Option categories: :T'I"I'| pack selection -
Tool pack update options .;i_lse Latest installed tool pack (recommended) P .
Specifically selected version Ty,

SRIE, B MPLAB X IDE {{EHE~T 1] Refresh Debug Tool CRIFFHRTE) KIFRQ, 5 A ff vk im a4 i)
B, EGREEAT LR B R LAHEN 25

AR LED BAMABEFHRNELERE, HS09.22. #8517 (LED)

PAT AT B R DA f R s e\ B 3

1. ¥ Mini-B USB 245 )RR 23 T .

2. FRUCUR PR EZ — R IE R %
Bk BAEE FHHEE Y Microchip 9V HEJE (AC002014) , ¥ H4H A MPLAB ICD 4, (B 72 M 5%EE 8
AR LRAR 3R T IR
5
FIETTE: WRARMAMEIEN IR, WET R RES AR R, iR NSRRI OV BT I
Hedy, AEHEAm AL 5 AR LRI & B A (TR
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5.3.3

BEMERRE

3. % Mini-B USB 45t a1 1828

4,  —HPA LED PN, LB MRS B IR I B2 ] (1 BB ) o i LED R R GRE SR
RE, BHEHIT T —H. R LED A M, NEREHATERIEREE NS, WHMSE 1 FhES T
.

5. 24X EH5 MPLAB X IDE 8 MPLAB IPE @ 3iEM5. W, ¥ ash Mo, Hikssk#irnEs
o 5EiE, LED R FRE, MIkS &0 b LIE.

wfTEREM TRR RG] S EARRERERF

o cnumon]| U FLICSE PR IRAE TS| S YA RS . (LT TSR REZEAE T L LIBAT R G

M DBUIEIL T, AR B f R A AR R 5 SR (B mAD) ; B, W SRE R SE S B E AL K 2E DA
TATAT
WA BT LED,
LED N fa.
« 5.3.2. Wi E 2 RR P A BT -

.a HE. WUl MPLAB X IDE v4.15 55 A A4 BT 5 SR SRR .

15 R 4G MPLAB X IDE 1332 83k 1 Debug > Hardware Tool Emergency Boot Firmware Recovery G > {4
THEEEFSEMERE) FRIUHIETEE.

[Debug| Team Tools Window Help
Ef Debug Main Project

Discrete Debugger Operation r
& Finish Debugger Session Shift+F5

(£ Disconnect from Debug Tool
Run Debugger/Programmer Self Test
(% Hardware Tool Emergency Boot Firmware Recovery
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BeffRE

WRAZ RS, VK S A S R B T . MPLAB ICD 4 BLZE W] LlizfT, JFHAE4 S5 MPLAB X IDE #if5. fn®
IR R, R ER. WS T IRAAR M, i@ support.microchip.com 5 Microchip i AK 7 FFHE R .
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6.1

6.2

L 1) R

AT & MPLAB ICD 4 12813 R G005 L i 3t i il 2

THEEE
SE A4 AR RS MPLAB ICD 4 ZE£R RSS2

MPLAB ICD 4 7E£k i 28 nTi85d ICSP #: 1 5 NG il s . e A TR X R HATIET . XT1E4: 8
frasft, HRAPITRERA TR AR .

DBARBITHRIAT TS e B oG H AR ?
BATHRT, FERPITIEF IEAET, FRAEBTRIEN NSRRI, RS S 5 H EFR S A ] .
MPLAB X IDE 5 MPLAB ICD 4 7E£¢ iR 28 Ml SR LIL K IH RO R B E L M ThRE?

MPLAB ICD 4 7E£5 ik 2@ i A7 T M A7 6 X b i R AT R AT i1 . R BUT RS fifk, REReSCIlsE &
HIBE AR, Wik 0 S FPGA. K%M SRAM X (1Mx8) FliEi® USB #2100, FLF 171 ssmug T I a4 5|
SRAM 1, IR AEE AT . a8 EE LR R BT O, 83 TP A FPGA HAEINIE 25 .

GRS L, BiRUI8 HB B B XS BIRIVTE MR . MPLAB ICD 4 7E4:1R A48 B R th i ZUX A ?
Bilgn, BT LARIEZA R B AR S AT R

EG RS — MR R 2SS A (-ME) #3H7 1. MPLAB ICD 4 7EZ A 885 H -ME, Rt B EAEAM R
LR ZE. MPLAB ICD 4 1528 2% 5% FH R 51 2 1 N B 0T s FRLER TTTAS 2 A3 T A, DRI L R 2R A s 38 e e P 35
AT MR

MPLAB ICD 4 7R RB R BRI 1N K2

Ao BT DRSS Bl A7 o I EDREHE R HUT . IERAEEHERE P PT RTA 2 HAE AR, 38 AT LB B W7 A3
Feol. (HRBEBEM AT, BAL, A LA E AND S AFLLL AT PASS 4L

PRHELR SR FE R L (R 1 ?

PRl ICSP-RJI11 £R45 (1 e K 1AM £10 15 MHz. J0it CPU B S fifif, R aCHA ] 1) 284 25 0 A0 23 DMK T b iR e
HDE7 kY 4 o

B, RS IaeS CPU BRI (i B ER /5L .

TERAEAE PN LK CPU LU sy B (541 40 MIPS) 3247, it 245 i) SLhrind fhid Al id 15 MHz, EIX 264
DUT, EREFMEEAR P EEie AT, I H A ICSP-RJ11 444,

XRBZHECEFREITEE?

MPLAB ICD 4 FEZRAAS A 7 AR A 7. Aot b b o BpIRASHLIAT

A LAYE R DMEATE 24T dsPIC DSC 24415 ?

MPLAB ICD 4 7EZ R 25 B 85 LA A 2080 Tk b 48 & I AR AT 28400 T S gk A7

B AY 7]
EBIE, PUTRRAM, SRR D ?

nE &= Run Main Project Elir ( |> h s MR e TR G SL R B 3hia4T. B, W RACRD XS N AE A7 25 AT
T, RIS ATRE R, BEPHIEAUS a5 AL RIE 4T, 5L HE Hold in Reset (fRHFHEAL)

RETTEHA B EMRIREE, HEIER RSB TE L. XREARE?

K A T A i OCHR AR RRAR ) TR IRAETHSENLERIE RGN« rR R T XHEAE & H rh 28 R ARHIR AR
o FRIRBREIR, JFRUHES “BHRIR” SEME. XA H R USB T R 18 K Fr A 815 .

REMIERERNEEN TGS, HEARRREFRS. TREARSE?
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WL R AR AR

X dsPIC30F/33F Fl PIC24F/H #fF, AbcizlZifeas H iy — MR AL GEE A bit 14 5 bit 5) H i # HIE
Freeze (%5 fii. WREXBNFAIBRPUTE SEME, BABRSSE Tk (FEEEERT, HPAATviR it

£ .

ST B A, 1 AR AR R AR MU AT S EE GBI BTS M BTC) , MIAENTEANFARIIT S
£ GEE Mov) .

{EF 16 AL fRRY, KRAET RINVEAL. Qe & ALK R E ?
FZJELLT A5 TH
« B AR, ERE RCON 7174
« TEHBIRSGFERT (Interrupt Service Routine, ISR) b3 FEHH . MAAHE trap. c FEAMRD, B

void  attribute (( interrupt )) OscillatorFail (void);
void Aiaétributegi((Aiinterruptgi)) _AltOscillatorFail (void);
void __a;tribute__((__interrupt__)) _OscillatorFail (void)
{ INTCONlbits.OSCFAIL = 0; //Clear the trap flag
while (1);

}

void _ attribute ((__interrupt )) _AltOscillatorFail (void)
{

INTCONlbits.OSCFAIL = 0;

while (1);

e {§iH ASSERT. #l#l: ASSERT (IPL==7)
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7.1

711

HIRHE

MPLAB ICD 4 fE£& il as &7 A S MR RS Hob— SRR R LB IR, RIS HNERRNE,
T AR A0 T LU 8 A RS R vk T, E DRSS T IR ARG R MR TCVEMR O B TR R
B, WS E

HHRH B RE

EiiE7 NpuRing e Lot
Failed to download firmware (GGiET#E 4
R AELE hex SCf:

g E.

o URTCVEMR RN, R WTZ ST AR CUARIR . EHT %% MPLAB X IDE.
WRATEAE hex SCAF:

«  HHi%%E MPLAB X IDE.

Unable to download debug executive (T FEiHRIUTREF)
T G 22 R R Y B e 5

1. BUEH R SEE R T A,

2. RMWIH, #5554 MPLAB X IDE.

3.  #EHE3) MPLAB X IDE, 4RJ5 EHHTIFIIH .

4, EFEFERRISE AR T E I R H AR
Unable to download program executive (JGiEF&BEEHITERE)
U R 2 G R A U B A AR -

B A R R s o
KHATH, #5554 MPLAB X IDE.

HEHiE3) MPLAB X IDE, ARBFEHHTHIE .
GRS N AR 88 I IR SRR H AR 281
IR L R AR, BB W 7.2.4. RBRA] ER .

PR R RER
The target device is not ready for debugging.Please check your Configuration bit settings and program the

device before proceeding. (HIR#{FRHIERITFHR. BREMBMEEIHEERME, RE%LE. D

AR RS T B AT R RN 2 o IR AR ARG AT I R R, sE AR R AR AR 1 e S R
B S

B R BRI R .

EERMTEAE (B, . SERESKRED KIS 3RIEAY, B, TiEmsssig. MamE M E,
T RE T fCrB {4 (Windows > Target Memory Views > Configuration Bits (& 11 > BAsfEfiGaaiiE > i &

£ ) .

BAR AR, AR S B T, A EL Configuration Bits % 11 B 1 BiiE BARM BB AL, ARG HERIEE
S m R AN B

WX LA FE T VARG A A, 1B 2L 7.2.2. PSR S B RS8R E MR B MR 7.2.6. IR LI IEF5

b~
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HAnsER
ICD 4 is busy. Please wait for the current operation to finish. (ICD 4 ii-. HF&4 4T BIETR. )
U SR AE 2 AR UK R R A i R A 2 Tl R B i U B R

1. GfF. ARSI B SE AT B AR A 55 o R E HEHT 2 ol U e i ol s
P |:| (EERRIR B2 RIF I AT HRINRER . 285 BB 2 O 2 FE I 1

R AT ML EIRT o SR B SR U e PR U
4. %M MPLAB X IDE.

w N

M ERSRIIES

R 71, B BHR T HES AR IE BB
AP_VER=FLZAETIRA o
AREAS_TO_PROGRAM=#;%if% L T 7E %X :
AREAS_TO_READ=H43HU LA R A7 A X :
AREAS_TO_VERIFY=§ £ 5 LA F 76X :
BLANK_CHECK_COMPLETE=% [k & 58/, #1F2 M.
BLANK_CHECKING=IE{EHEAT 25 (IR #E e e
BOOT_CONFIG_MEMORY=5| St B 77 4% .
BOOT_VER=5| Fhg 4.

BOOTFLASH=5| SN 4.

BP_CANT_B_DELETED_WHEN_RUNNING= H A5 #8247 I Toik# BT sl . Tt sUKEAE R IR B ARSR 4 2 15
PATIFFEBR

CANT_CREATE_CONTROLLER=JCIE$L 2 T B2 2535

CANT_FIND_FILE=F7%k 234 %s HIALHE

CANT_OP_BELOW_LVPTHRESH=JTi% Hi i %f (% T f /MR FL E %f o IR HLE R JEvk gk 8 T4 .
CANT_PRESERVE_PGM_MEM=TGiE (R R T A7t 25 : ORGSR da il = %08x, Z5uitiiil = %08x.
CANT_READ_REGISTERS=TCi%iH H br & 1788

CANT_READ_SERIALNUM=TCiE B HU 214 /551 5

CANT_REMOVE_SWPS BUSY=ICD 4 1%, BRI I E R 8 I .

CHECK_4_HIGH_VOLTAGE_VPP={%%: Ki# MPLAB® IDE FiEHE M1 (%s) & A SYHER: 3R T2 A%
PEARTE . G SRAEIESE 3.3V 4SRN LS SV 43fF, W& FEH ST E AT ID W BUAST. 255 B AR SRR

CHECK_PGM_SPEED=/& B4 4a P2 fE 15 B N %s. HLESHR 1) B nT R BR IS8 . B T H Bl E
THCN AR FFE IR R ERE,

COMM_PROTOCOL_ERROR=##{ T H L Bl E 4R . T HK R A7 H N R R Bkt .
COMMAND_TIME_OUT=ICD 4 51514 %02x [ R AE S o

CONFIGURATION= & .

CONFIGURATION_MEMORY =/ & £ 4% .

CONNECTION_FAILED=3#$#%; K .
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HIRIE B

CORRUPTED_STREAMING_DATA=Kll B TC R BRI . (84T I WL SR BUR ER 00 v REA A 2. U0 R AR )
Rl o

CPM_TO_TARGET_FAILED=ControlPointMediator. ToTarget() & H: I 7 # .

DATA_FLASH_MEMORY =44 [N 1717 fik 2% -

DATA_FLASH=%#}& N7 .

DEBUG_INFO_PGM_FAILED=Fik#E N, FUNRRE BRMAERM . BT A Rt S 80X —

DEBUG_READ_INFO=%Z H {54l ¥ w18 B 5200, 78 YRS T se AR AR Tl RE e SRS (8] o 48 /N s B ) 3
(fEICD 4 i H J& 1 ) AIEARIX—1E0 . H k3 dEnl F 76 0 B 28 1 i

DEVICE_ID_REVISION=2&1f ID fz A .

DEVICE_ID=#f4 ID.

DEVID_MISMATCH=H### 4 ID (0x%x) 2T ID. S H et 1% .
DISCONNECT_WHILE_BUSY=_1 B7£ &1 W T

EEDATA_MEMORY=EEData f#fi##2.

EEDATA=EEData.

EMULATION_MEMORY_READ_WRITE_ERROR=24ii$/5 MPLAB [{){/j EL7-t# 2% i A 3% HbhiE=%08x.
END=453.

ENSURE_SELF_TEST_READY=i# i RJ-11 £ 25i% 4 20 J5 F 4k 4k .
ENSURE_SELF_TEST READY=i##fif# RJ-11 2245 45 DI IRAR 5 gk 4. 15 Bgksr?
ENV_ID_GROUP=#{}#5iH.

ERASE_COMPLETE=#F ] .

ERASING={&[g -+ -+

FAILED_2_PGM_DEVICE=#{}4mfe kI .
FAILED_CREATING_COM=TEikfI@@E % (RI4Com) .
FAILED_CREATING_DEBUGGER_MODULES=#J#A1k kM. Bz iR e L.
FAILED_ESTABLISHING_COMMUNICATION=JE % 2 7. T. K il .
FAILED_GETTING_DBG_EXEC=2%1R I#k A $h A7 F2 o i) H 30 il Rt
FAILED_GETTING_DEVICE_INFO=#Jia LR : IR HEEIRE Cpic) {5 B K.
FAILED_GETTING_EMU_INFO=#T4AMH R 17 AR (5 B IREURIK .
FAILED_GETTING_PGM_EXEC=218In#gm 2 $ATHE 7 it P i L
FAILED_GETTING_TEX=Jti%:3K X ToolExecMediator-.
FAILED_GETTING_TOOL_INFO=HJ#afL R : R THEHEE Crid) (5 BRI,
FAILED_INITING_DATABASE=#]451k 2. Toiwlaa b T B AR FEXT & .
FAILED_INITING_DEBUGHANDLER=#J4A{k R : Toik#IthE{k DebugHandler 5t % .
FAILED_PARSING_FILE=[H {304 %s fi#br 204«
FAILED_READING_EMULATION_REGS=1/j E 17 fi% 8% 5 B 2 1 o
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FAILED_READING_MPLAB_MEMORY =i 525 %s 17 fiti 5 (11 %0x08 % %0x08 4 -
FAILED_SETTING_SHADOWS=Ji%: IEW X B T 3 /2ot .
FAILED_SETTING_XMIT_EVENTS=Fi%k [T i G 5 8.
FAILED_STEPPING=Xf H #z#54 H b AT J I

FAILED_TO_GET_DEVID=#5F ID SRHURM . LR B AndsfF O iEsH Bk ZA R E.
FAILED_TO_INIT_TOOL=ICD 4 #4160 .
FAILED_UPDATING_BP=[Ki i BEH e 3CfF: %s, Hilik: %08x.
FAILED_UPDATING_FIRMWARE=572: 1E A 58 37 [ 44 .
FILE_REGISTER= /% 174%.
FIRMWARE_DOWNLOAD_TIMEOUT=[&{} %3 #2341 /8] ICD 4 i .
FLASH_DATA_MEMORY =X 77 5 77 fits 4% -

FLASH_DATA=[N 1744 .

FPGA_VER=FPGA ffi 4.

FRCINDEBUG_NEEDS_CLOCKSWITCHING=Z/E iR T H FRC, AU RER#h D)3 BL B 18 . 51 RE
A 4 I H R AT R R

FW_DOESNT_SUPPORT_DYNBP=247i ICD 4 [ {t: A SCHF A Fridh 284 B B IS AT I W s o 18 T 2l 14 hie
K %02x.%02x.%02x B 5 =il A -

GOOD_ID_MISMATCH=H#r#fF ID (0x%x) & A R #8F ID, (H5EFERHHAEL ID (0x%x) AILH.
HALTING= {1+

HIGH=H8F

HOLDMCLR_FAILED=1f45 4 {7 54 .

IDS_SELF_TEST_BOARD_PASSED=ICD 4 IE# T1E. WiIREK B bs A7 R 8, 153 A4 B i) Target
Board Considerations #4)

IDS_ST_CLKREAD_ERR=lli{#% [l PGC % £ 52 UK ML
IDS_ST_CLKREAD_NO_TEST=illi{#% [l PGC B} Z& 5 R £
IDS_ST_CLKREAD_SUCCESS=lli{4: 0 PGC 4 £k S BT -
IDS_ST_CLKWRITE_ERR={lli#4 1 PGC W42k 5 N2 M. 0 AR 8s i B A
IDS_ST_CLKWRITE_NO_TEST={lllif#% 1 PGC i §hk 5 AARZ MR,
IDS_ST_CLKWRITE_SUCCESS=illift$ [T PGC 42k 5 A\ sl .
IDS_ST_DATREAD_ERR={lli## 1 PGD #4252 B 2L 4 .
IDS_ST_DATREAD_NO_TEST=illi{#: 11 PGD $# 2% st SR 4 Mk .
IDS_ST_DATREAD_SUCCESS=lli{#% 1 PGD %#/& 28 52 U T
IDS_ST_DATWRITE_ERR=lli{ £ 11 PGD $# 25 A\ K
IDS_ST_DATWRITE_NO_TEST=ll1{# 10 PGD %5 £k 5 A\ A& &M
IDS_ST_DATWRITE_SUCCESS=illli##z 1 PGD %445 N3 -
IDS_ST_LVP_ERR=ll{{$ 1 LVP il 28 i
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IDS_ST_LVP_NO_TEST=lli{#% 1 LVP $&ill 2k K 2 k.
IDS_ST_LVP_SUCCESS=illi{ 1 LVP #= il 2 M s -
IDS_ST_MCLR_ERR=Jlli{# 1 MCLR H3~F-i#f%
IDS_ST_MCLR_NO_TEST={lli{#% 1 MCLR Hi-F- K Z Ik .
IDS_ST_MCLR_SUCCESS=illi##: 11 MCLR H3 -l )

IDS_TEST_NOT_COMPLETED=#% AlIATGVETE M. 1HER R M) FAE/CAE %4 1E SAR R4t FHR28 1 3Kk LAk
ITHEAB U

INCOMPATIBLE_FW=REAL ICE™[#E {45 MPLAB X 34 ) 241 iR A AN HE 2
INVALID_ADDRESS=#:{EEik4k4:, K N%s Hutibe H 2% 4okt 75 Bl 0x%08x-0x%08X .

MEM_RANGE_ERROR_BAD_END_ADDR=W{ 2| Jo &g 2 1 [l 45 bk %s . 16 7E 13X LR “Memories to
Program” (ff4mfEfifitias) B LA FshmFEvu .

MEM_RANGE_ERROR_BAD_START_ADDR=!{ 3| Jo &k 42 o L da ki %s . 1 7ERIR LA K “Memories to
Program” J& 1t U3 A4S & F2h g AT o

MEM_RANGE_ERROR_END_LESSTHAN_START=W R EmFENLE : 45 Al %s < il %s. 1E7EEIR L
Eff] “Memories to Program” J&: i [ A & F5h Jm R 6

MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=Y{ZITo dmtzva . 45 Athik%s RN 55 215E 2 1) 0x%x ikl
WA HAERRTER “Memories to Program” J& 4 7 [ b4 7 T3 A2 Ta .

MEM_RANGE_ERROR_STARTADDR_NOT ALIGNED=U | F a4 ftifll: el %s 4k 5 556 24 1) Ox%x Hi
LS. EAE R T B “Memories to Program” J& 2 T b4 25 - 2h 2w A2 36 il

MEM_RANGE_ERROR_UNKNOWN=2% R 561F FH 2 1\ 1 A7 fith 25 90 Bl I H IR R
MEM_RANGE_ERROR_WRONG_DATABASE=TE 1A 7E 56 AIE FH 7 i N B A7 ae i Bl I 7 1) B st %2

MEM_RANGE_OUT_OF_BOUNDS=Fri&gm#2 it F Y%os ARAEATEAE# X FIIERIEE AN . #E/E I T EK “Memories
to Program” J& M UL Il 4G 2 2)) 4 FE V5 Rl o

MEM_RANGE_STRING_MALFORMED=%£ “Memories to Program” J& ' Ui [ 4 N IFEME RS0 El (%s) AR
IEHkE =K

MISSING_BOOT_CONFIG_PARAMETER=TGATE £ 2t 4k B 5| 30 B AL 4a/ 45 il .

MUST_SET_LVPBIT_WITH_LVP=1& B & 4uf2 D §e 75 2 1L B AndsfF LAH6E LVP BLE A7 . 5 FREbEL B AL k2K
(=N

NEW_FIRMWARE=IL{EN H brasfF (%s) TEGHfF: %s
NMMR=NMMR

NO_DYNAMIC_BP_SUPPORT_AT_ALL=4HI & A SCIFESMF IS AT I BB T o W1 UM AE T B AT 234 2 HiT M.
H.

NO_PGM_HANDLER=TCiZ: 4w A2 P il A2 B i AR A4 1L «
NORMAL=IE# .

OP_FAILED_FROM_CP=/J1if R MR ME R, BN 32 BACRS R I«
OpenIDE-Module-Name=ICD 4
OPERATION_NOT_SUPPORTED=fTik #$ AN st #E R
OUTPUTWIN_TITLE=ICD 4.

PERIPHERAL=4}4 .
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HIRIE B

POWER_ERROR_NO_9V=Ft & N T Em B At b, (ERGN 2] OV BFiHFL. EHHARINE OV AL iffLiE#2]
CEL,

POWER_ERROR_NO_POWER_SRC=FEC & & H¥rtk BT L, {H Vpp L ARKMZEUETHEE . W #fRE T H bRtk
HLE IR R

POWER_ERROR_POWER_SRC_CONFLICT=Ft & Jy M T B8] H bri ff e, {H Vpp L ORI EI B E. &2 —Fhpp
Ko VEMHIR HARARARTE ) T B3R 4t B % = i

POWER_ERROR_SLOW_DISCHARGE=Vpp FUT-HZRIIHEE, FERGNBLIGHICH . R RKFEE D
A LS SRR B SR B AR P P KB G L AE N

POWER_ERROR_UNKNOWN= % = o 41 HL Y 4E 15 «
POWER_ERROR_VDD_TOO_HIGH=fii 7 Vpp H L HEHE. THEH 5.5V 1Rk KHE.
POWER_ERROR_VDD_TOO_LOW=Ji Vpp HEHEH L. T&T 1.5V i/ %,
POWER_ERROR_VPP_TOO_HIGH=fii & Vpp HLIEHBH L. T H 14.2V B KHE.
POWER_ERROR_VPP_TOO_LOW=Ji{ Vpp HLEEHTEHE . BT 1.5V (/N E.

PRESERVE_MEM_RANGE_ERROR BAD END_ADDR=Ui |5 &% {4 ¥4 7i B 45 A bt %s . EE R T AN
“Memories to Program” J&: i [ _E A T 5h 4w R 6

PRESERVE_MEM_RANGE_ERROR BAD_START_ ADDR=!{ |5 24 {4 ¥ ya Fl it af bt Y%s . EE IR T E K
“Memories to Program” & i [ _E A6 2 T 5h 4w A2 6

PRESERVE_MEM_RANGE_ERROR_END LESSTHAN_START=W 3| AR HETEHE: g5dihht%s < Skt
H%s. WELERR T A M “Memories to Program” J& I i [ k2 T3 gmiE e .

PRESERVE_MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=U#I T % FETEFE : Zh sttt Y%s AKX} 55 258 24
) Ox%x kil Ao B IR T E A “Memories to Program” J& 14 7 il L& F-5h n AL Ta .

PRESERVE_MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=U&#| LR BETE M . #LiEHNE%s A X 55 5)5E
2 0x%x kil A, EA R IT AR “Memories to Program” J& 14 I 67 FhmAva .

PRESERVE_MEM_RANGE_ERROR_UNKNOWN=2{R561E F - 4\ % B8 Y0 B 2 A R AR
PRESERVE_MEM_RANGE_ERROR_WRONG_DATABASE =ik AL U6 FH 2 i N (K70 s 5t BRI 7 1) 08 o 42

PRESERVE_MEM_RANGE_MEM_NOT_SELECTED=/& Clit B {1l — Mg X, (HiRGFmEZAHEX . BT
Wik TEAMK “Memories to Program” J& M TH _EAT AR EAVE L, HAAOROR BE AT A0 A7 A2 A0 4 8 N dmAE

PRESERVE_MEM_RANGE_OUT_OF_BOUNDS=fTi% f & i i %s AR 1E ATk A7 X B IERE I N « & 78 PR T B
“Memories to Program” J& UL [ A48 & T 3h gm Vi e

PRESERVE_MEM_RANGE_STRING_MALFORMED=7Et “Memories to Program” J& 4 1T [ -4 A\ 1 8 B £7-fif o v
(%s) AR EmHS

PRESERVE_MEM_RANGE_WONT_BE_PROGRAMMED=7£ “Memories to Program” J& {4 7T 4\ # £/ B 77
BIUE (%s) MR T ARG8T mFE i (%s) W. EAERRT AR “Memories to
Program” J& M4 JUTH] b 25 OR B9 ¥ Bl

PROGRAM_COMPLETE=4i F&/1 5 5% % -
PROGRAM_MEMORY=F2 17 # 2% -

PROGRAM=%if%.
PROGRAMMING_DID_NOT_COMPLETE=%#F2 K 5¢ ..
READ_COMPLETE=1H{58 -
READ_DID_NOT_COMPLETE=#H A 58 i -
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RELEASEMCLR_FAILED=M\ & i # 5 2R 1K
REMOVING_SWBPS_COMPLETE=# /4 W st i 3 52 i o
REMOVING_SWBPS=1E 75 | B 5 A 7 st +- -+
RESET_FAILED=%3144 fi M.

RESETTING=IETE & i+
RUN_INTERRUPT_THREAD_SYNCH_ERROR=&’EHN#BizfrfiiR. @EF B Bl gkstizfr, |
BLEIZ AT I T RE W] B VR IEH TAE.
RUN_TARGET_FAILED=T%iz1T H st
RUNNING=IE/EiE1T -

SERIAL_NUM=/#%5: \n
SETTING_SWBPS=1E7E % & W i --- -

STACK=HE#

START_AND_END_ADDR=j&2 it = 0x%x, &gl = 0x%x.
START=j24f .

TARGET _DETECTED= |21 H A5 HiJE o

TARGET_FOUND=#k 2 H #5221+ %s

TARGET_HALTED= H tx#3 F 2= 44T -

TARGET_NOT_READY_4 DEBUG= H tnas R #ER LT . 1 ERLE A % B I miEantt, ANE4ks:. bl
W DL ER) JER R S 41 9 s /B PGC/PGD % E .

TARGET_VDD=H#5 Vpp:

TEST=illik.

TOOL_IS_BUSY=ICD 4 %1, 5% 4aT#AE5E K.
TOOL_VDD=VDD:

TOOL_VPP=Vpp:

UNABLE_TO_OBTAIN_RESET_VECTOR=ICD 4 Joizfu R EArla il . XFRmAKE X _reset 75, FibA <M1k
B IERES.

UNKNOWN_MEMTYPE=771i% #$ R il
UNLOAD_WHILE_BUSY=ICD 4 7ESS U 18 fEFRMEA] ICD 4 225, &K T IFEHEs USB 4.
UPDATING_APP= 1E7E 537 [ {1 )52 FH R e -

UPDATING_BOOTLOADER= IF /£ 5 [l {1 [ 252 /e

UPDATING_FPGA=IE{E S # [E 1 FPGA:------

USE_LVP_PROGRAMMING=E: U5 Z i F K B R g nt M s A b AT 9w A2, 1 E X 1 HEH i # Cancel (ML
M) o SREEFIE B L Real ICE i85, Ik Program Options 165525 5 % #% (1) Enable Low Voltage
Programming (ff R HEfE) RIEME (K HE EgRAEN R REETLRO .

USERID_MEMORY= F* ID f7fii#%
USERID=H }" ID.
VERIFY_COMPLETE=A4 12
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7.2

7.21

7.2.2

7.2.3

7.24

7.2.5

VERIFY_FAILED=HK 4 2k 1

VERSIONS=}ji A .

VOLTAGES=H1/%.
WOULD_YOU_LIKE_TO_CONTINUE=/ 75 Z4k 48 ?

B T
DL 85745 F (i L T % it T A e A 1 I R
EIG R BT
IR RS S R
1. 25EHT Debug > Reset? MA/E T Be = A3/ 5 4%
2. EREE. ZERT R R KE—K.
3. WHRAERRE LRIF AN BREIER. GXRREERE, HS LS 0EETF.
4. R E B AR ST IERE B (PGC Al PGD CiZHED .
5 XFEHR, #HREIFEIREE Program Options ik “Erase all before Program”  (4ife2 i & 55#EER)

(. 8.2.3. Program) .
6. HALRAT ARSI IER .

AR5 Hinss @GR B

5% MPLAB ICD 4 fE28 8% 5 H AR F 2 (8] AR :
1. %% Debug > Reset, #RJ5 B #ElE.

2. HRARFTAE £ SR A R R

AR ST EN B RYIERTE

st MPLAB ICD 4 72 825 5 MPLAB X IDE Z [A] /R AE i1 :
MITENL R NS, RIGEFFHAN.

EHER A,

EiERIE. 2R R R A —IR

N~

TEF5 it PR 1025 TR
5. 5N USB i I A BEAEAE 1) . 152 WL 7.2.5. USB i B4R 24 16 #5 7iti

IR EE

1% ) FRAR W] B T MPLAB X IDE #2235 AR 2 s 1R 512 Y
1. HEIFEN LA 1 MPLAB X IDE KA.
2. EFwIFT R MPLAB X IDE A,
3. WS EUKIAAEAE, TE R Microchip FAR SRR

USB i B 54574 IR i

% 1 FRAR AT L by T3 o 1 b A A AR SRR

HHri%ER: MPLAB ICD 4 7E28 8% .

H R R 28 T P B S L 1 3E 24 % USB 3 1.

B ARAE VAR SR T b e 8 738 2400 USB 3 11 (L 8.2 TR ik T £) .
R USB it D ARl A 5 448

IERAE ] USB 422048, 15 HfR O L.

SUEEE S

P22 35 ¥ MPLAB X IDE RAT] it 5 MPLAB ICD 4 fE£8 8% Fhndk i B A AR —3. 1% 7.2.4. IR
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7.2.6

7.2.7

7.3

6. WitRE ik USB WL -

TR R M
MPLAB ICD 4 72 AR T HUT R REAE . 51 R RNTRIRERZ . iES I 5. SEMEME .
A E AR IS e

PR IR AE ATIORL I AR RLZ R A BT T Microchip P4 -
B BRI S e33R (7.2.4. BRI B ) S
SRR R R REREA L .

1. R EHE 3 R G DR % 2 8]

2. WREESE LA R0 AR G BRI 2 MR
QIR AR ARAELE, TR Microchip $ AR H#¢.

EISES RS
THEAHH T MPLAB ICD 4 7E£8 AR 23 115 B8 2.

IDS_SELF_TEST_BOARD_PASSED: ICD4 is functioning properly.If you are still having problems with your
target circuit please check the Target Board Considerations section of the online Help.

(IDS_SELF_TEST_BOARD_PASSED: ICD4 IEfEIE¥ TAE. REK Bir BB IEAE RS, EERELTEBN
“Target Board Considerations” (BFRERER) #Ha. )

WS W 9.5. HFRERFI
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RSB TREILE

a1y

8.  HARSURICE

AREFLE T MPLAB ICD 4 7E£R 185 hk .

8.1 WA EE ST #
{§ 1 Project Properties X iGHER] A0 H ik F ) fik2% . ZHAT YR, WAUE 2 AR ST EVIAHZE. MPLAB X
IDE il i SR AN 7 515 R X 43 & AN IR A
B R A e A R R A
1. AT T IHRAEFTIT Project Properties X i Az :
a. i Projects & M WITE 4 %R, #RJ51%+% File > Project Properties.
21
b. A Hd Projects & I I H 4 #x 3%k F% Properties.
2.  {EEMI Categories T, JEJF “Conf:[default]” DLE R ICD4.,

3. ff£ Hardware Tools (fifift T.E) T, L% ICD 4 I-#.;/F%5 (Serial Number, SN) kB35 H w48 1
Rt REHd Apply (READ .

8.2 A Tk
1E Project Properties X ifAE H % & i1 211 . 7E Categories T i ICD4, [ i Options for ICD4 (ICD4 [1)i%
) (WWTED . f#iH Option categories THiFIFKEREAFIET . For3EANIE T 4 FRATLE T [H 1 Option
Description GEIHEAH) HEHEE H UL, B de 144 FR 007 00 ml 6] HodE A7 i B3 B .

TE: A I BL ROX B Hh (32 I kTS B A A 1F o
8-1. MPLAB® ICD 4 f#ji£1

Categaries: Options for ICD4
=@ General P _ _
' """ 2 File II"IC|USi0I"I,'rEXC|USi0I"I . Dption CEItEgDI’iES: .Memoriesto Program v.
= @ Conf: [default Click . .
@ f— here tO \Aute select memories and ranges _hllow ICD 4 to Select Memories -
@ Loading i Configuration Memory (always programmed in deb...
- @ Libraries dlsplay g 1y (abway rJ. g
% Building OpthnS Boot Flash (always programmed in debug mode)
=- = XC32 (Global Options) Program Memory
@ xe32-as Program Memory Range(s)(hex) 1d000000-1d 1T
i @ xe32-gec
_____ o xc32-g++ Preserve Program Memary [l
e 2 %c32-1d Preserve Program Memaory Range(s)(hex)
o xc3z-ar . - .-
Click on the option name to see the description

Option Description

WEETG, #id Apply 2 OK. i3 #iidi MPLAB X IDE {X# R &7~ (1) Refresh Debug Tool El#x ® , SEHTETN
AT AT B 5L

PUR #4548 17 T RERIIE I -

8.21 Memories to Program

Wk H AR BRI Aty . R R R 1T AT RERIE ST, (H A AT H T A i 85 1 AR 0K 7R 7E MPLAB X
IDE .
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RS REIL S

. NSk 8.2.3. Program ik ] Erase All Before Program, U4 2 Wi R 2 IR B A 231 47 1% 9%

% 8-1. Memories to Program i£ 1255

Auto select memories and ranges ([ 3k A7 1 ds 17
ED

Configuration Memory (it B 17 #%)

Boot Flash (5| &A%

EEPROM
ID
Program Memory (F&F77M#2s)

Program Memory Range(s) (hex) (F&F1Efg2siaE (+
yAvE il DAD)

Preserve Program Memory ({f#&HFEF17fiE4s)

Preserve Program Memory Range(s) (hex) ({£EFEF 17
fEESTE L CHoSitEmD O

Preserve Memory ({fE7Z0i%8%)

Preserve Memory Range(s) (hex) (ff£EETEfkasTamE (1
AY:ia 1 DD R

Allow ICD 4 to Select Memories (72 ICD 4 & #1E 4%
) —— A SRR L BRI 3 AN ER A 15 B 8 B R
A5 H . Manually select memories and ranges

(FRNEFAMERRANEED —— T E YRR AR
BATEE (T30 -

1 RN AR AL A s B AE B IRAE A X I o AR 2R AE
UL T e %A1 25

15 HHN LKt 7/ -2 A A A B AR B R A X
FE BT G A i A7t s o

W HHIN AR EEPROM T B8 75 4 A2 O X 38
A g AR 1D

15 RN T 2 AR N T A€ B H AREE A A T

ERIE AL 2 T E . Bk, Rt
27y I TR Ko oA VY oW L e < a2 L2 o N e
VG AR P 7S b £ (R 4 46 Bk AN 45 AR b
Wby, XA ERILREIT . 2ANEE 2 DA E S
FETT (fFltn O-ff, 200-2fF) . I8 L6 2%} 5% %1 0x800 kil

GEZS

AFt
W M E A E N TR . BRI RER BRI
LT K -

I AN BB T IR E 1 H AR P AP A . BRI
A Z RS RY

e ISR IR I B AR FE A7 g Hh B AR B R LG AN £
A SR TEE . AR XN E bR e i B H 7 o
A ) MPLAB X IDE 72X .

WPy SR B Memory UL HEAT BB A,
Memory Ffif#i s, KA AHE: EEPROM f7fifids
ID 1k a% 5| FINTFAHE BT fEas . RIS AN 2 A0
Ry

TR BRI H A5 Memory Hh B3 BF R AA A 4h R
FNHER TG . Memory NTFERERSRR, G
EEPROM f7fi#%. ID f7f#as. 5l N7 2R
BEAF A XN H Fras sz L8 2830 1) MPLAB X IDE
X . BRI A ZARS AR

A0 SRR USRI R AS IERA T FE 51 RS A Jm AR B R, A ORI R R L T /) AR 8 AR A i 2 O T R

Debug

T AR TR T . CHR SR e X5UmT 200 H T P 284D

# 8-2. Debug LK H
Use Software Breakpoints (i FH &l 50

3 RN LA AR T e T I R NI R B . TS
UL, A S W Aoh I S 2 3 5 S RO L
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8.2.3

8.24

IR REILE

2 8-3. HAFHT R SRR BT A

185 LB

i 2 TofR
W 5 A2 RE P A7 fi d
LB W AT )
B
Wr {78 # (Skidding) ¥

R
IR A

Wk TIRGadEE—— W REFR 2y R

f

W A AT R 2 R S RO A BRI, RO ERE DU ANy A A L A g AR A i A

Program
IEFRAE I AR AT R R B2 A 3R 2 5 AT
2 8-4. Program &34

Erase All Before Program

Programming mode entry (ZwfEti=iE A )

LED Brightness Setting (LED 75 % &)
PGC Configuration (PGC It &)

PGC resistor value (kQ) (PGC HFHE (kQ) )
PGD Configuration (PGD fi¢ & )
PGD resistor value (kQ) (PGD HH{E (kQ) )

Program Speed

Freeze Peripherals (ZGZ54M%)

BB ZIE T 5 5E M MPLAB X IDE 92454l 2 i 2 %
BT IMREASIEIS, ARMTHEE N R B AOA7 i X AR AE
ST PR ER AT O B MAR RIS . BRARAE BT B
CHEEBR I 1E, BHERLAUE P UL REHE. FoRIEF IR
HHE, AT SAF AT B AR AR IF AL AU R 5 A A
CAEAE AR 5 9F

%L € MPLAB ICD 4 FI T4 H brds fF B T 9l
W7k, TR AETTE, Vep A2 Vpp HIEH
Je, Tt Vep SEHTIRBE. Xt T e S gt 75k, Hf
Xt Vpp Hi AN OV (KL -

RN G F110 (R MRS,

BT E R S T PGC &R (R4, bhiek
) o BRI, A FHAE B R A PGC A FHAR S I sk
7E o

Fi\ 0-50 Z (AR FHAE . BRIAEN 4.7 kQ. @R PGC
BLE X E N none CB) , NIZB&IZ{H .

#%FE none. pullup ( EF7) B¢ pull down CFHL) . BRIk
ATz, HBA{E R THK PGD HFEAE G AE .

i\ 0-50 Z [ IR PHAE . BRMEN 4.7 kQ. W3R PGD
BB B N none, N ZHRi%{H .

PR AR TE H b o A BT . Low (IR
) . Normal CIEHIEE) B¢ High (FiE) . ZRikK
Normal. IR GwFEIM, T FHARTEE AT R 2 i e i L

MANEBIZR T FERE 7 8 5 I R 5 BN R 5 (K A e AT P AMBEER R T- 284

PIC12/16/18 MCU 34

SEAE RS I IR G (OIS TR 45 I A A A BE, TR /UL “Freeze on Halt”  CEIFRREE) SIEHE. GnAX AL
Prash B, AR, AN EHEN R ThRE, DT i 32 a2 o

© 2019-2022 Microchip Technology Inc.
KH A AT

HPieE DS50002596F _CN-Zf 38 7T



RS REILE

dsPIC30F/33F. PIC24F/H 1 PIC32MX 24F

XtF “Peripherals to Freeze on Halt” (E{EIEELERIING) FIRFRISMNGE, &P FEASMERITTAEE {5 1 LR
HyH e b T LA R 7 BHE B AT . IR RAETIR BB B HEASME, Wi+ “All Other Peripherals”  (Fr HiAth
ANEE) o WNRIX IR RMET T AN R (S, R, FIMEERA B RS ThAE, R JCiR A2 PR 2R

EERFAFE “All Other Peripherals” YENIFTA M, N Hd Check All (k) o BEEUHIEF TS “All Other
Peripherals” fEPIFTAE M, T H Uncheck All (A 3FHUGHESD .

8.2.5 Power
PRI
% 8-5. Power 255
Power Target Circuit from WHREHZE T, N V@ ICD 4 v BAREESAE R . A NAZUEH SRR (L 3.2.3.

ICD 4 G#id ICD4 ~NHIRH | BFpftr) .
PR AL D

Voltage Level CHLJEAR/N) W%+ “Power Target Circuit from ICD 47 Si%HE, MIRMEFRAR AL B4 Vpp
(1.2V-5.5V) .

8.2.6  Secure Segment (Z4£E)
PRI A% .
# 8-6. Secure Segment LK
Segments to be Programmed CEZwFEH] | LT H i — ANk
BO + Full Chip Programming (45 4f8)  CBRA)
Boot, Secure and General Segments (5| 5. 224 BAIE B

 Secure and General Segments (224 BoAEH B
+ General Segment Only ({3 H B

8.2.7 Tool Pack Selection
SRR DR AR AR [
% 8-7. Firmware ([EfF) W5

Tool pack update options 1% Use latest installed tool pack (recommended)} Use specific tool
pack.

Specifically selected version (&1 7Jik | HdEI Al G HFEZEHN TAM., Bd)E, ¥4I Select Tool pack (i&#% TR

FEIRRAD A0 WPEAE, AT A H I R T R R RRAS o

8.2.8 Clock (EF%f)
W B M3 XU AT g T A4 £ P PR P4 B RC 4
2% 8-8. Clock &S] (4

Use FRC in Debug mode (dsPIC33F | i, {#H28MFEBEGE RC (FRC) AN RN FH 48 T IR % 28 KT L
and PIC24F/H devices only) (FERR | &f, X 78R NP8 126 H .

B R EH FRC e rh SRR N M2 4T, HAE PR FRC 3 EEHEAT M1
ﬁg)ﬂ[iﬁ dsPIC33F #11 PIC24F/H % H O B S R

E: RN, RKSE SN OR Bl FRC & EIZAT .

8.2.9 Communication GEfZ)
BB IEH TR AER H An s A5 2 A I
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IR REIL S

% 8-9. Communication E 245

Interface (3H) AT IR I R 1
Speed (MHz) GEE (MHz) ) R 2 171 3 P 110 338 5 38 Bl N 3 o
e HL R S A X IR X R 2 i) AVROZ (#27. No High Voltage (TG HLE)

——ERNE . Simple High Voltage Pulse (&8 H L k) —i% TR
F 2R i s e R kP R R B . AR B IS BN, it R R
L4211, User Power Toggle (/7 HIEYIH) —— R, Rk
AN P U H R A IR, — B T AR BIERE, tBERE i
5] Iz B R HE e R kv, AT S5 I AR R AT BE P AR

{£ /] UPDI % AVR S 43T 9752

VRS SR FH 5 R AL 0E AVR 48— w2 AT R4 0 (Unified Program and Debug Interface, UPDI) . fEEH
UPDI &S] % AVR 234+ &, wrlidid & RSTPINCFG Bt & £7:K UPDI 51 HC & A GPIO 5{ RESET. N 1 #i47iE—
SBgAE, VIR A B FH e R S kR Sk B EGE UPDI 2 0. (6 s e R kb iy, A R R 8] UPDI £ il
LR AT LA SZ 270 12V ik

GPIO 5 UPDI #4EX 5l

2 F o ikl B B S UPDI 200, FE S R B 1, (A2 TR ARFF UPDI SHAEELR] N —IkE L. F—IRENL
ZJ5, IR EI2] RSTPINCFG BLE 48 € ML E . BAEEN K5 MECE N UPDI, HH P %40 RSTPINCFG it
B H g E UPDI.

¥ RSTPINCFG Bt & A GPIO I, AT PAHAT IR & 1E, H5| NG Ik B E Sy UPDI, FE B ANREFH/E GPIO 5] .
% 8-10. SYSCFGO RSTPINCFG[1:0]&: B fi;

0x0 GPIO
0x1 UPDI
0x2 RESET
0x3 R
© 2019-2022 Microchip Technology Inc. FF#aws DS50002596F CN-3 40 1
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9.1

9.2

9.21

9.2.2

BEAERLTE

TRV

AZEPEIRT MPLAB ICD 4 /£ 28 A 2% 22 48 T A4 0 Ya A B S S o

USB i Hi@fE
MPLAB ICD 4 7F 45 8 4%l 74 USB 2.0 fRZ[#) USB i 15 B ML HLER:, USB iEEE8Ar TR 2 il
R G USB 432 11 3 25 [ 1 .

AR USB £ il as i, (2 USB R LB T RN ol < MAE R, TTEM T HARft . RIS 2
ShERFLYE. ARAE USB MV, ZUH IS AN RII R RS, F 20l USB 424t 300 mA [, A REfiZiMik g /e
P TAERE GRS/ gfEds) N IEW TAE.

¥: MPLAB ICD 4 fE£k i A 2s i@t H USB i#EREfit i . BHARHUN B & iRt .
BREKE —E AR T EE RN 7 IEW TEFTRKER T -8 E L.

Beel AR LR G USB SRS, VU C R B RN . RSN, LN 1Y USB 3 DA T 5
T3 T AR 0 M

THENURERA AR —— 25 LT AL BRI B LAt T R, DL R 5 I R ) IE 3 USB Ji A5 .

MPLAB ICD 4 7E£ A28

PRSI L — NN HEIR . —ANFMEE USB 58, RJ-45 JEBSEHI—A OV DC HiFiESSe . Hikeesh 72 g —4
FensTar, HPaEHA LED.

F HERR
F IR A DU R
— M Arm Cortex-M4 A% 32 A7 88 Fr#L.
—/~ USB /i i 3% 480 Mbps 1 USB 2.0 # 11,
o ANHTFE ARG R SR E T2 FPGA.
— AN TFAREFE ARSI % ) SRAM. bW FH T 4 FE AR _E INAE 384
* W1 LED.

#ER4T (LED)
MPLAB ICD 4 28 T 5 1 751 N :
1. BRE——HREL 3P4,
2. WoO——2%ER s T B R AR, AR 2 Fho
3. Ht—— . Eikas.
TRAEWTHTFERIEERITHSEE L.
% 9-1. LED Rl A 38R 3L

EHEHER
e W HRCER:: IR B FRURE
e PN C.2k+ Power target circuit from ICD
4 (% 8-5)
© 2019-2022 Microchip Technology Inc. FFars DS50002596F CN-3f 41 1
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BEAEALTE

........... (%)
SN e Kk Power target circuit from ICD
4 (W3R 8-5)
eyl % H %27 IEFEBAT
H e R
NN af BAE R
®E % S AP e AN I St N = R
F IR [
HEREFHEIR
£ 28, BTN AR Vi I A 2% (1) #2477 EEPROM I 4
- eih 2L, PURNER TS B 5 F2 T AP 4
o, PUE LR FI, PRI AR T HL R A AT i
9.3  EfSHEM

¥¥&E: MPLAB ICD 4 A Erifit=k.

EARAE S BARMR Z AT ARG (3.1, WIRER5E BAMRZ BIMERE) , BEHEA RI-11 EBERIEE A .
K 9-1. Wi

Target

IE 30 | MFLAS

cD4

/ / =

See Note 1 See Note 2

1. HRE RN BEHEEIHRRAELR, E309.3.2. FrAEEEM 9.3.4. il RJ-45 L 404 IR 2 iE 23
RJ-45 HiriR .

2. fAR¥ R BLREER:S RIA5 LG R, ES W 9.3.1. % RI-11 BILRAT 443 R85 11 RJ-45 $dfLAN
9.3.4. i RJ-45 ML A AR IS IE T RJ-45 HARR .

9.3.1 # RI-11 BR A ER2HAS -1 RI-45 fRFL
MPLAB ICD 4 £ AR 2 A T 5 H BUEE 1) RI-45 #8085, RI-11 B 45 5 RI-45 2 2310 E 07 AR fAj 51,
HEB RI-11 BILL5 46 N RI-45 E B2 1O RIA],

A RMER IS I, ES LT,
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9.3.2

BEAERLTE

&l 9-2. RJ-45 G755 RJ-11 BB 5) B

RJ-45 Socket RJ-11 Connector/Cable
w
[~ w
[{a] Te}
Te) =t
-+ o |
[Se] ol
o -—
5| RJ-45 ThRe 5| B4 RJ-11
1 T™S EJTAG st x0i%e 4
2 fre
3 PGC (ICSPCLK) FrRAEEE 8/ TCK 2 PGC (ICSPCLK)
(JTAG MRS 20D
4 PGD (ICSPDAT) P UEIE (S EE/TDO 3 PGD (ICSPDAT)
(JTAG MR HH 4
HO
5 GND Hy 4 GND
6 Vpp_TGT H bR L LR 5 Vpp_TGT
7 Vep LR 6 Vep
8 TDI JTAG MR E s 4 A
PriEIE S

VA S H AR BRI T4k R AR B 77 . BEE SmlE (Vep) LA Vpp M IER:, LG REAERH
FRas P 75 R I Bk AN B i 2

Vpp o BB AT A2 R D OV 2 14V BT AR L e, DL 2 4 58 117 FLAR B4 ) FL R 2R

Vop Hrl 4 A H bR AL 8 R IBO A B rE . SEPRIIZEoK B MPLAB ICD 4 7R IR R 48, K4 Vpp 21
S RIER ARk . Vpp EHEE G HIT KRR

I B R A B AT LR R 2

e AR (S B e P (BIf7E 4 ) MPLAB ICD 4 7E4k it 28 R4 (i 2 dnit)
B B AN B HRAS 5 A 52 DR % B A 2R SR BRAS 240 2 5| 6 177 vy FL S PRS2
i B AN TR (S 5 7R 52 R P H A 2R 45 vt B0 00 36 17 511 RS 1 K REL IR 1) B 0 o

&l 9-3. 6 7| HIARAES| IS TE

Pin Name Function
Standard Socket 1 lvep Power
2 |VbD_TGT Power on target
2 4 ° Bottom of 3 |GND Ground
1 3 Target Board 4 | PGD (ICSPDAT) | Standard Com Data
5 | PGC (ICSPCLK) | Standard Com Clock
6 Reserved
© 2019-2022 Microchip Technology Inc. FFars DS50002596F_CN-3 43 7T
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9.3.3

9.3.3.1

9.3.3.2

9.3.3.3

BEAEALTE

£ 9-2. HSPHER
SUL R TIN Viy = Vpp x 0.7V (F/IMED
V||_ = VDD X 03V (EE_X‘j('TE.)
ﬁiﬁ:iﬁﬂj VDD =5V VDD =3V VDD =2.3V VDD =1.65V
VOH =3.8V (HE_X‘/J\ VOH =24V (%/J\ VOH =19V (HE_X‘/J\ VOH =1.2V (EEi/J\
8D 1B B 1B
VoL =0.55V (&K VoL =055V (k| VoL =0.3V (&K VoL = 0.45V (&K
(D) 1) (D) 1)
TS LR B AR 3
PRl 5 8 R 2R B B B RS A B AR N H . TIHIFIH T A R 8 S HoE BeAs e
AL B S T

Hir, #E%S5——AMP Incorporated, 555165-1
o fQHPH, 14w 5——Digi-Key, A9031ND
TRER T HA B A FIARSAEEAR 5 S B L5 RS RO R . X E R AL T A TR R AR ThAE .
9-4. B iR FIBEELL TR 5 5| B 4B

16
/4
Modular Microcontroller .

Connector Pin Pin

Front View of Modular
Connector on Target Board

6 Reserved
RB6
RB7

Ground

VDD Target

VPP 1 6

S IN|w(hA~|lO

Bottom View of Modular Connector
Pinout on Target Board

HE R, 4% 5 ——AMP Incorporated, 5-554710-3
REF, #{F4n'5——Digi-Key, A9117ND

BEHAL R BTG
HliE R, #4495 ——Microchip Technology, 07-00024. R4k E (L) N6 Ji . @iEAEMGHKE#T 6
GO IR £R B, DABE G0 7B /2 RIS F A
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BEAEALTE

Rl 9-5. B ib L4

6 inches
g L |

- % -
Q

|
Pin 1 Pin 6

9.34 @it RJ-45 AR R AR EES] RI-45 HITIR
MPLAB ICD 4 4R R BA T 5 BFrBGRE K RJ-45 &R . ¥ RI-45 B ERES| RI-45 8. KRR
A — iR R) H AR K RJ-45 R .

FHRMEREN G SR, EHSILTE.
[ 9-6. RJ-45 4 E] B AR

Target

RJ-45 Jack RJ-45 Cable

12345678
12345678

87654321
87654321

9.3.5  EOKSIHE
XFAFER SR, wAEERAS S MThaEa AR . ARIFRMBEERE D, E2 LT 5 R .
E: AREZELEME, EHZ P REE T0 LU E 2 DR 2D .
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BEAEALTE

EE 9-3. PRI O3] B4 AL

5| | B[ |ICSP MIPS Cortex® | AVR® | DW AVR_ISP | TPI

B*ﬂ B (MCHP) |EJTAG SWD JTAG (IRE)

1 EEE i

8 |TTDI TTDI MOSI

7 TVPP MCLR MCLR MCLR

6 | TvDD VDD VIO_REF | VTG VTG VTG VTG VTG VTG VTG VTG

5 GND GND GND GND GND GND GND GND GND GND GND

4 PGD |DAT TDO SWO TDO DAT DAT DATA MISO DAT

3 PGC CLK TCK SWCLK TCK SCK CLK

2 | TAUX | AUX TAUX RESET  SW- CLK RESET | RST
DAT

1 TTMS TTMS SWDIO TMS

£ 9-4. FIERBEOK S| HHE

MPLAB® ICD 4 BT

8 TX CH# MOSI
7

6 VTG VTG
5 GND GND
4 MISO
3 SCK
2 (SCKD

1 RX CH#m) SS

1. PERERAE.

9-7. RS ERIX (AC102015) 5|j4r-Ed
HEREN S F JTAG. SWD #1ICSP i, &M T kL4 AVR®H F L.
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BEAEALTE

20 PIN (ARM) 0.10 RIBBON ‘

7 TMS/SWDIO

NC

9 TPGC/TCK/SWCLK CORTEX
Debugger Adapter Board 5 TPGD/TDO 4WIRE
Part Number: AC102015 4.6,8,10,12,14,16,18,20 | GND JTAG SWD

1 VDD

15 TVPP/NMCLR

13 TDI

ARM SWD + JTAG (20 PIN)
MPIS EJTAG (14 PIN) —— 8 8 8 8 M

14 PIN (MIPS) 0.10 RIBBON

7 T™S
ARM SWD + JTAG (10 PIN mini) QC TBGCTTER MIPS
3 TPGD/TDO 4AWIRE
MCHP Universal 245810 5D JTAG/EJTAG
; ¥ (8 PIN mini) 11 TVPPINMCLR
5 DI
\ 10 PIN (ARM) 0.05 RIBBON
0.050 INCH CENTERS 3 '(I'kMS)/SWDIO
ey
4 TPGC/TCK/SWDCLK CORTEX
0.10 INCH CENTERS 8 TPGD/TDO 4WIRE
359 |GND
; VDD JTAG SWD
10 | TVPPINMCLR
6 DI
AVR JTAG (10 PIN)
8 PIN 0.05 INLINE
8 [ TMS/SWDIO
7 ICSP
6 | TPGCITCK/ISWDCLK SWIRE JTAG
2 gﬁ;%D’T DO 4WIRE JTAG
= 1voD 4WIRE EJTAG
2 | TVPPINMCLR SWD
1 TDI
10 PIN (AVR JTAG) 0.05 RIBBON
1 TCK/SWDCLK
3 TDO/SWO
L RS TAC
2,10 GND SWD
6 NMCLR
7.8 Not Connected
9 TDI
9.4 ICD U8 DAk
A ARG UE PR B R TS IE W TR, FHRHTCL T ER1E:
1. BIARZE M B AR AT B LB o
2. ERTEHLZES0E 1ICD Ml DR (AC164113) EEZFIF A .
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9.5

BEAERLTE

&] 9-8. MPLAB ICD 4 B335 Otk

o ok~ w

Power from the computer via USB cable

\

USB Cable
to Computer

ICD Test Interface Module

Modular
Cable

MPLAB® ICD 4

F R R R EAL,

SEILK USB 453 1 50HL )y MPLAB ICD 4 .

JA3I MPLAB X IDE. Fi{fElA 0 H 438550 .

%% Debug > Run Debugger/Programmer Self Test CGiR > iZ/T RIS/ AR EA) o SR)FIRBREMNR 4

JE “ICD 4” FH#.4f OK.

N

R 1ICD M BRI Ui . Hiili Yes (&) 4k%E.

8. {EIAARNT Output & &R HARE K. WRNKEIET, #HERT A%

Test
Test
Test
Test
Test
Test
ICD4

interface PGC clock line write succeeded.

interface PGD data line write succeeded.

interface PGC clock line read succeeded.

interface PGD data line read succeeded.

interface LVP control line test succeeded.

interface MCLR level test succeeded.

is functioning properly.If you are still having problems with your

target circuit please check the Target Board Considerations section
of the online Help.

9. WAL BRE, TR ICD W EE DA R BT o

WA AT, R B 2R EE . HAR I, 1 TE support.microchip.com H4i A ticket: K Output & 1A
25 R G 2] ) A R

H AR B T
AR s 5 P00 52 FR FR9 SR 1) BB o

e AR E R AR A S s T AR — SR AR  FTREXT RS RIS K ATERR . b
RAE AR ATTEAE FIPR AR, AR BAFAE LR R A 2l AR BRAE RO 00 N 5T IR AR . 85I ]
TARERIAE AT, HATFErETT R8BI .

PR AN H AR K. VDD _TGT A 182 kQ 1%
WG AR 2S5 H bRt 2 (848 @ 5258, HARR B DL RIS 0.

3.2.2. HistRIEE A
3.3. PHIE S IE 5 A A s %

© 2019-2022 Microchip Technology Inc. FF#aws DS50002596F CN-3; 48 1l
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RS 52

10.  jRApI 52

101 [RAA (2017 £ 8 )
ARSI IA -

10.2 fRA& B (2017 9 A)
BAT T/ BT DU AR, JEHEAT 1 AR DB,

10.3 jRAC (201845 AH)

BAT TAREIE, SN T A ST A B 2R e A A TR R 25 SRR E SR E R BB TH
SR A A 8 T A U o

104 R4 D (2018 10 A)
B T A SRR B BB B AR 2 155 RO XA RO AR 5 B4 O £

10.5 FﬁjKE (2020 £ 6 A)
TR TR SORAOR, EAE R T .
MR T R T, B O TR A PRI MY N 1 A5 JE R I
o BTRMEEBRENS, BT i AR A B .
o BB ISR B s EA K H AR
o I T A RIS SR AR A B ARBUS AR IR RE .

10.6 JRAF (2021 10 A)
o EEASCRIPER TXHRBCREISIH, IR T A 9% MPLAB ICD 4 A SRR SR TR -
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1.

1.1

1.2

X

SCRF

ARIFFRE, EZ LT &

RizFd
1 1 18] www.microchip.com/mysoftware 7E£8vEM T H . a1 4& AR H4A myMicrochip ik 7, 7] DL Tz S 471
Mo mPEELEIHE A, 158 RIF R Register Hardware Tool GEMEfFTE) .

FELEM T RS, Sy DASCEHT = i B 5 2. AT4E Microchip Xk b SR I R H AR A o

myMicrochip ™AAIE 1R S
Microchip A HEALIEEIAR S A B T2 7 7 f# 2T B i Microchip 7 & FI5BCHHE B . M P AT {EE 22 7 i R 51 BT
RUBRAAT . B RARA S RE R, 3] o fs i AT

WM I BRSO A N 1) B IR T, 1 A
www.microchip.com/pcn

Z M TR FAQ AIVE M PRAE(E S
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12.

RiER

RiER

Absolute Section (Z4%7Et)
BB RE E (45 bk GCC 4w asEL.

Absolute Variable/Function (ZixIZ5&/R%0)
{f ] OCG %wiF#311)@ address 1y i & 78 465 Hi bk 1125 & ol pf 4.

Access Memory (PUBFEBUEAEX)
PR PIC18——PIC18 344 ) — Lefp ik ar 4795, STIX e ap 238 U5 10 5 476 X i 7 479%  (Bank Select Register,
BSR) M LK.

Access Entry Point (5B A H 5D
PN sl 7 —Fh ik, v s BOR R 5 8 B AN T BE AR R R 2 UM pR B eI ORI B R 5| T BRI 22 4
N B o

Address (Huhik)
FRIRAE 4 A B E

Alphabetic Character (FRF4F)
TR RE TR TR (ab,,z,AB, ~,2) FERTH.

Alphanumeric (FREFF4)
FRHCE A BEE PR R (0,1, -+,9) LAk

ANDed Breakpoint (384547 %)
NEFFEERE “EBES” &4, WRBRA 1AW S 2 R BN, 7B EEF. XA EBE KT SRR i
BT [ I R A I A BE S

Anonymous Structure (EB44514k)
16 17 C g df—— KA & M4 i s o

PIC18 C #hieds—— @ T C BR A I R IR dn 44 G A A o B 44 Sl A A4 il 573 mT DAL 5 Sl R A FRT BB & A4 PR Bl 572 — g
T i, ECLTIAREGH, hi Al lo Bk caster H 1B 4 S5 MR I UL

union castaway

int intval;

struct {

char lo; //accessible as caster.lo

char hi; //accessible as caster.hi

}i

} caster;

ANSI
FEE bR, 23R E TR AHLHERRHER 2

Application (Ff)
A PIC®H 5 HLAa ] () — 2R S A

Archive/Archiver (JF#%/1FR432)
VRS R P e H AR G . B 2 NE SO IENC g6 o B AR SCHE, SR a8 AR 8% 2 B B2 1G B A SO &
AN VARG SR A e TR AR/ S B AR AR ORI AR TR R B R, AR T AT A
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RiER

ASCII
5k B AE B AR RS A ] 7 A SRR A TR TR R R . OSSR B 155 DURE
7.

Assembly/Assembler (JL#RiEFNCHID)
ICgmiE 5 2 U S AR S RN L R mAETE . LA g A D B LA L i = T A

Assigned Section (E4-HE)
TEREHAR O & U O B S H AR IX ) GCC mikat B

Asynchronously (F2)
AR A 2N o 38 SRR T R 7E AL BE B HAT AR (R 2 I 280 R AR 1 R BB

Asynchronous Stimulus (F:3505)
JREF AL 32 B R A A ADL B A () A/ i N T 2 P B o

Attribute (B
CiESEF T B EEN GCC Kk, - THikEr 2 THLaS T .

Attribute, Section (B, B
Bt GCC Hf:, tw “mPAT” « “Hue” 8 “Bds” , BN IfEILS#% . section AR H i NirdE.

Binary (—i#t#)
RS 0 F1 1, LL 2 ARSI SRl AR FoR 1 IS, AILS A RN 2 B sk, AL = AERoR 22
=4 fE4, DA,

Bookmarks (%)
i B2 AT AR A M A 4R S I8 B AT

7F Editor (4ifEa5) T.EAF2Hi%#F Toggle Bookmarks (FFeH5%85) Al /bR 4%, iz TEA EHALER TR
HEF =A%,

CIC++
CiEFR - MEAREES, BAMSGHNREN. JUEHIRMEIEEH, UUREEMRER. C++2& CiBSIIHR
XGRS .

Calibration Memory CEEHEFFAEX)
FF1R47 PIC 5 ML RC 735 28 B A /M BAR AR ()P 5K T i 2 A7 28 B0 FH 27 788 .

Central Processing Unit (HJt4bB1 85T

WA—Esy, FFRBUHEPATIIEFTES, WHRSEATIRG, REPITHES. WRALE, EHEREZHREIT
(Arithmetic Logic Unit, ALU) —t TAERSE RIS HIPAT . EIEHIFEF A28 b 2 28 . B 7 6 28 10 M kb i 28
FUKFHERR D7 1]«

Clean (JEi&
1B RS EE S I E BT TR R E SO, B B AR SO hex SCEEFIVEASCME . gmiRaii BB, BT HAh o fE S
I,

COFF
NICERR AR XA ) B AR SO SIS s AR S .
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Command Line Interface (f74-4T#10)
T SCA S N Y, AERE R A P 22 TR AT 38 A 1 — by 2.

Compiled Stack (Zwi¥HiR)
IR N, TS AR R U7E B RS E - T0VE DU A SR P HEAR I, g AR AR
BT,

Compiler (4gi%%%)
SRS S IR SRR LS AR T

Conditional Assembly (Z#/C4%)
FET 48 E I8 AL BRI A B3 B2 BT 4 1 S R

Conditional Compilation (%&#t:471%)
P A 25 Dh 48 4 5 58 5 R0k 3N BUN A 4 B R 7 B 1 1

Configuration Bits (BlE {r)
A H 4R R % E PIC MCU 8¢ dsPIC DSC TAEME AL A . it B A7 il 3R o] F 4 e o

Constant (¥ &)
Fom—SLENEE, BB S .equ DR TE TR E I E Lo

Control Directive (¥#|th384)
YL i 5 RS R IR I A 1 A RN 0 & sk 2RI e 4

CPU
B W A RLL PR T

Cross Reference File (32X 3| F3CH#)
B SR R S HSS IS FIR . WRE X TS, SIS AR AL E . Hfhs o a s
XEFS 5 H

Data Directive (E#E{h#84)
B 48 4 2 PS5tV 2 28 KRR P A7 2 B B AR B 3EAT e O FR R A), BT RS (R E X4
O 5l B I 7% .

Data Memory (¥iEfEfE8)
£ Microchip MCU 1 DSC #3#F+, HlEf7igas (RAM) HUBHZF 78 (GPR) FI4FRINAE /79 (SFR) k. K-
LE 23R4 EEPROM BUE 174 2% .

Data Monitor and Control Interface, DMCI CE#E IS5 #5417
BS54 5 (DMCD /& MPLAB X IDE H i —/ T E. Z A a DA I0E A 5 R P2 E R s &%
o N RE A B T DA 4 NS iR S O R EER— N EE T I EE .

Debug/Debugger GRR/ A2
&2 W, ICE/ICD.

Debugging Information GGEi#{5H)
Gm PR AL, FEIE B, SR AR R 1015 Bk TN AR P ARG . D6 Tk BRIk i v 5
B 1S W4 PR 4 B G 2 SR
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Deprecated Feature (ZFTEE)
FH 75 52 SR DRATS SR S R E i 2538 0 T Tk R B R M h iRk .

Device Programmer (5S{4:4n7252)
T E T gmAe e SR as . (i il AT gmfEn T A

Digital Signal Controller (¥#{5 S4%4%8)
Her (s 5 ahlgs (DSC) R HEAHTFE 5 4FEE /1 A HL (B! Microchip [¥) dsPIC DSC #14) .

Digital Signal Processing/Digital Signal Processor ($F{55 43 /375 S0 a8 )
v 5548 (DSP) ¥ 755 UL OB v (RIEREERD RIS S (FEeEB) Mt Emlat
B, 55 A R W TR E SR A FE A .

Directive ({484
EARTD FR R AEHE T T A ER T I HI 0I5 ) o

Download (F#D
T EAAKBEE N EN R ERN HAR S (W ERS . mFEgssl Hirt) it

DWARF
AR E ik AR . DWARF &M T ELF AR R E B g .

EEPROM
H P S FR I T 2 P R SRR A . — T BB R ARSIk PROM. — IS B — AN 15 8idis . EEPROM B H 35006 P
BREOR B N7

ELF
AT PATEEEAS o XFPS B AR SO E LSS . AR H A (E 2 ] DWARF f55E . ELF/DWARF w424t F
COFF fflitb AR5 i

Emulation/Emulator (fFE/MFE %)
®2 I ICE/ICD.

Endianness (B#i%)
ZF N B AT

Environment (Gfi%)
MPLAB PM3——L 5 ¢ F Uiy 5 2 gmFE 1 ST STtk e o 3092 mT LR #5231 SD/MMC

Epilogue
G e AL AR A — B 70, DOSUREIHERR S 18] . IR A A7 8, DASCHIAT IZ AT IR rh 5 5 O AR T LAt R 5 T ALt A 22
Ko BARSLES E R B AVERT ] P ARAD 2 J5 . R ARAE B BR8] 2 BT AT

EPROM
FIHERER TP iR RO Ar il as o T W IEI 5N B R B R K ] i F R IR A 2%

Error/Error File (GEREMAEECHE)
RIS R A Ge Ak S A B . T, S LB, HRIE R R bR IR BRSO Z AT S . BRSO
T HE T T REA A RE B E R
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Event (Bf4)
SR bl . BUE. BT AhERE N . RIETY (EBAEL/S ) KA R A L R A . S TR
iz W7 R R BT

Executable Code (RJ#4T/8HE)
AL HE N SRPAT IR AE

Export (5H)
PUAR AL 8 4 288 M MPLAB IDE/MPLAB X IDE &% H .

Expression (Fi&)
F S AR B8 3 FAF o BRI 1 BB 5 1

Extended Microcontroller Mode (BB HFPIER)
Y B YR, BRI AR P gy, Wnl NI Ed . SRR A g il KT PIC18 #3441 P 51
TS|, $AT B shPI#k B4 AE i A o

Extended Mode (FBf#z) (PIC18 MCU)
EY EERT, mixel iy E#4 (I ADDFSR. ADDULNK. CALLW. MOVSF. MOVSS. PUSHL. SUBFSR Al
SUBULNK) AR 57 BI#As b 5k

External Label (4MF#55)
HA I BBERERIbR S -

External Linkage (M4
AT LATE S8 SR BB AR i AR E A s B kAT 5, e e i B A

External Symbol (JME#75)
A MR AR IRFE TS o X AT R — A5 B — AN E X

External Symbol Resolution (SME45#3HT)
Bl F AR SR PTG i NS I M A 5 1 SORARAT BT AR5 51 RIS AR o S AN 8 U AN 5 5 # 4
BUR S BERE AR R

External Input Line (JMF#IAZR)
F AR AN AE 5 % B S AMT NG S @ HRE 28 (TRIGIND

External RAM (#}#5 RAM)
O ANER SR B AT S o

Fatal Error (F(frsEiR)
S AR B R IR R . AR AR HARE R

File Register (3Cf%7E52)
FNBHEEMESS, AF5EHSER (GPR) FIERDIRE A Ees (SFR) .

Filter (&%)
JE T 3R B A AT PR i S B SO TR R TR R L R

Fixup ({Z1E)
FEAEPE AR L 2 , fd F4aT Mok B e B AR SCHERF 5 51 FH RO FE
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Flash (JRFF)
L (AR 5 R EIR K —F EEPROM.

FNOP

SR S HRAE. SR NOP JEAZXUE M8 & 15 — AN . BT PIC AL AR IR ST, AT 4T 2 1) R
TR B AL R )R — 2648 2. (HAE, WURMETE R TR TH R, AR TR M 2k T, S
—A g NOP Ji #.

Frame Pointer (p#84})
IR HEAR L, HE T HEAR I S AR T HEAR I J5 30 AR 4y BRI H8EE . Sy i) 24 /1 R 20 )55 57 48 = A A (L 3
HETHE.

Free-Standing CHisr)

— PR ZARFIAME B A BB TR AT SRR P I SE I, T BRI RS, XTEE S (ANSI 89 MRl k2K 5H 7 %)
WU AR B, AR AR Sk CF<float . h>. <iso646.h>. <limits.h>. <stdarg.h>.
<stdbool.h>, <stddef.h>Fl<stdint.h>FH%.

GPR
WHFAS . SRR ER (RAM) —H85, (E—BHE.

Halt (E{%)
= EFEF AT . AT Halt 55 7E W7 54042 1A 7]

Heap (3#)
TS TR, A AR S8 PUARIS AT I8 2 AR R 3547 23 BCATRE A

Hex Code/Hex File (Hex ft#%/Hex ()
hex {8152 LA+ 7S ik il % AR Z I AT AT 8 2. hex AREDELETE hex SCHFH .

Hexadecimal (5t
fH % 0-9 LU 7R A-F (ki a-f) , DL 16 AREETHEUAT . 78 A-F FREN 10-15 CHkdD i+t
Fo ABMMER 1 G, A5 T ARR 16 EEL A% =A1Rr 162 = 256 K%k, DL,

High Level Language (B&iES)
WMERFIIES, SILMIESMLL, ST BRI LS.

ICE/ICD

L K/ tEZe it a5 FIT0 A AR At AT Ml M R R TR . (7 188 B LIRS E 2 I Thag, HlanER .
AL R 1 26 v A3 FHAE 26 07 32 25 BRI 83 AT 0 H BRI AT N o

-ICE/-ICD: i 1EL A B a i B (284 (MCU 8 DSC) o 1ZA R 2B 7E 05 Bk A b, IR il 7E 4R
D7 LA g HEAT I K

ICSP
FEL R AT R o (] H AT 3 5 A D B X 25 51X Microchip iR N X 881 FEAT AR 753 -

IDE
FERT KBS, tn MPLAB IDE/MPLAB X IDE.

Identifier (FRIRAF)
RHAL BT RS .
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IEEE
AT TR 2

Import (B \)
B EE MANEBYE (Fdn, hex SC) 1£31% %] MPLAB IDE/MPLAB X IDE .

Initialized Data (2¥J#E4LEHE)
FHRIIGME 2 XRIEdE. 72 C

int myVar=5;

T TR AF TR SRS B ) — AR R

Instruction Set (3§448)
R A A IE S R A ES .

Instruction (34
A A BT TR E R, RS BRI P B R B A A

Internal Linkage (P3#%H)
U B MRE SRR B AR B AR AN T 10 AT, USSR ) o Kk A B LA P S

International Organization for Standardization ([EFizHEALELR)
FUTHZ AT B AR (BIFHHEREE) J5HebsER— N, A 1SO.

Interrupt (-l
fEiB 2] CPU {55, '&fff CPU B{FHAT IE/EIS TN TR, FIEHIBE 4 R Wik S 2T (ISR) , DUAbFREE{t,
TESERL ISR B, RIS B FHAR 7 1) I AT

Interrupt Handler (F1¥iib2Ef2E)
JR AR R T A A B R ARSI TR T

Interrupt Service Request, IRQ (F¥TIREIER)
8 A0 3 BSR4 IE W BOHE BT H I EPAT R WAL BEFR P i) S . FELRAb BB UM P IS R F 4, R BE ARG
I

Interrupt Service Routine, ISR (FFHTIREFEFE)

AT A AP R

MPLAB IDE/MPLAB X IDE: 474z v Wit i3E N1 FH 7 AR B ARAS o ARRDZERE 7 A7 il s o (0o B 08 % ke T B 7 2B mh i 11
%A,

Interrupt Vector (HB[AI&)
FH BT R 25 A 1 B T AL BE AR ) b

L-value (£f&)
51 F AT A 2 A/ S AE U SRk . A RIS R AR AE 1 22

Latency (WRIFERT)
A5 LA 3 B 2 TR PR FE IR ]

Library/Librarian (/&)
e AWl =l =t
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Linker (G333
B B FRSCAERN 2R ST A2 A SR AR AT AT ARRD FEAAAT — MBS 53 A — ML S - S S T A

Linker Script File (g8 3044
BEFERE IR SO R BERE AR P & S . e AT SUEERER BT IR H ART- & LR A A7 25 .

Listing Directive (F]&fy#54)
FIR a2 RAIBHNC g A TR SR iR 2 BRI B, 53 DU H A S R 2

Listing File (F)3&304)
IR SCAE B H AR C IR A A BRAIHLA IS P58 R R AE 2 140 280 F5 4 8021 ASCIl A

Little Endian (/230
Z TR BRI ALE], EXMHLEI, RS ER R L

Local Label (JFEB#55)
JAEBFR S F ) LOCAL thig &7 — NN ERE XIFr S . XEhn S48 T2 LB — e sedl. i, AUA
local 1755 fbr 5 7638 5 ENDM %% J5 AT AT Ui 1] .

Logic Probe GZHERsH)
Microchip FI3ELE 07 FLAS i 2 AT 4R 14 DNZHRIREE . WP AL/ MTIRER RN . AR E S . +5V MAILE

Uity o

Loop-Back Test Board (Ff[EIMIEHR)
FIF-lik MPLAB REAL ICE E£5 4/ L 22 (1 Zh k.

LVDS
R Z G S . —ME AT ok (R TIRAL) Bt iR s . RDIFE. (IR BT

XFTARAE /O 15 S84, BORAAEMRIB T SCbr R RN . R ESZ &K (R, gk, Xl
JERE) o EXFT LVDS, fHESds (GE N IE 5 i S E AN, AR SEPRE RN B, Bodls vl DA S A i 2 Bt B
B, FRRRT . — BUNEEEIR

Source: http://www.webopedia.com/TERM/L/LVDS.html

Machine Code (H18%52)
ACHE S SE bR MR R P TF BN F R oR . 3ERINSS R B — RIIWLES IS (TREEE &) dk. HEAFrE
LIS ITE RS MESTRNEN “f84HE” .

Machine Language (Hl38iE7)
R T AL B BT FR A4, AN TR R RD AT A R BS 1 A .

Macro (%)
Fi4 . USHBRARREL TS .

Macro Directive (34
Fa i 22 58 SR R PAT TR 2 liC P38 4

Makefile
¥ H T Make i B 354 5 H B — /N0 mT i S0 fd IS make #5475 MPLAB IDE/MPLAB X IDE 41 Make i
H.
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Make Project (Make 3jiH)
FOH N R T a2, AN B IR 1 50 U SE S T RS

MCU
H M. microcontroller K4 SR . HWE1E uC.

Memory Model (f7f#a3f#R)
T C 4mides, $8N AT I M X MER. 5T PIC18 C 4nifas, & ik, T8 ER AT ST
EFIRIEL

Message (JHE)
BN HRISCA, BEEET THOREP TR M. HEARSE 5 E.

Microcontroller (A1)
LRGSR, TAKE CPU. RAM. TEF/EMEE. /0 i L FIE R 28,

Microcontroller Mode (B HIEER)
PIC18 ¥ A HLH I —FiFE P At dsfic B . A AU, (NARENEHAT. Bk, 8PS SO AR
S

Microprocessor Mode (fi4b#igs#R)
PIC18 M A LI — MR A IR E . EMUE BB, AMEFA T AIRFAEGE35 . BEANTE P AP0t 23 A B0

Mnemonic (B1ic#)
] E R R LA 1 SCA YR 4o R NERIER .

Module (i)
PESCAEAE AT TRALBE 2R 0546 4 2 JR I TRAL B4 . tBAR ABIIR 3T .

MPASM™ Assembler (MPASM™ L %i#%)
Microchip Technology i -T- PIC #. /5 #l. KeeLoq®%&4:A1 Microchip 17-fif 88 2% 14 1 1] H & A7 I Sw s -

MPLAB Language Tool for Device (T84 MPLAB &% L&)
FT-¥8 2 #5£F 1 Microchip [1] C gmiFay L gnan MIFEEEAY . RIEN AT AR FE S T HRE, Flan,
F A PIC18 MCU 4m'5 C 15, #tit#H T PIC18 MCU () MPLAB C 4w 4% .

MPLAB ICD
Microchip HI7E£2iHi%%%, 5 MPLAB IDE/MPLAB X IDE Bt &{# 4. %2 W, ICE/ICD.

MPLAB IDE/MPLAB X IDE
Microchip FI4 5 JT & 315 . MPLAB IDE/MPLAB X IDE Fififft e 2% . T H & P 38 AR AR 38

MPLAB PM3
Microchip K8 9mFEas. FIT X PIC18 ¥ HLAI dsPIC®¥ 715 S5 #3379 F2 . 75 MPLAB IDE/MPLAB X IDE
Bo&fi i, Wl sfdiA . /8% PRO MATE Il.

MPLAB REAL ICE™ In-Circuit Emulator (MPLAB REAL ICE™7E£R{f B 5%)
Microchip HI¥—AELD H %%, 5 MPLAB IDE/MPLAB X IDE &/ . 1520 ICE/ICD.

MPLAB SIM
Microchip HI#/FR2S, 5 MPLAB IDE/MPLAB X IDE Bl &4, ¥ PIC MCU #1 dsPIC® DSC #1%:.
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MPLAB Starter Kit for Device (T84 MPLAB A7 HA)
Microchip FIATT L RGTEEEFH ARG ESMM T FE ST NE. BEFRLERNNRAER, RERRAmEEEC
R B 4

MPLIB™ Object Librarian (MPLIB™ EiFEESHEE)
Microchip [/ ¥1%%, 5 MPLAB IDE/MPLAB X IDE Bt & {# /. MPLIB FEE L2452 FH T-K 1 MPASM L% 7%
(mpasm 5 mpasmwin v2.0) 3 MPLAB C18 C #4123 il ft] COFF B AR 2l & s e S 1) B AR e B2

MPLINK™ Object Linker (MPLINK™ H #34#152%)

MPLINK %43 %3 5 Microchip MPASM JC 4w #$ 1 Microchip C18 C 4wi%#$H) B ARBEEES . tHTDE MPLINK #5348 5
Microchip MPLIB JE & FLEFEL & . MPLINK £ #:2% %11 N7E MPLAB IDE/MPLAB X IDE H{§i ], RE T AT
T MPLAB IDE/MPLAB X IDE {# /.

MRU
B R R . 577 )\ MPLAB IDE/MPLAB X IDE 3 F 3 B b 438 1 SC - F 5 11

Native Data Size (FHL.EFEKR/N)
XFAHERES, Watches (W%2) % 0 A AR B FE L 05 Bk 23 4F RO BR A 28 K EEAR R . X4 T PIC18 234,
NFEFKE, T 16 g, NFEKE.

Nesting Depth (EREIREE)
AT HoAh 2 (R B R

Node (F)
MPLAB IDE/MPLAB X IDE i H 2014

Non-Extended Mode (3 B#ER) (PIC18 MCU)
AT BT, WMEFESRASERY Bs S M BIEAsnt FHak.

Non Real Time (JESLA)
FEALTE 2 40T 7 A B IEAE BB AT T 4 80 MPLAB IDE/MPLAB X IDE IEiZAT#E A iR

Non-Volatile Storage (I£5 KMTFEMERS)
P O PRI R A7 N B AR A 284

NOP
TR PATIZIEORT, Bk TR 1 AN R T AR R .

Object Code/Object File ( HFLR3/ B30
HARARRS AL H L G 2 B R A AL AR S . HAR SO S HLARAS, P R & RS BRSO BT DA B A
175 BONTTESEALN, FE S B AR SOt G serE) BBk A R se & T AT LT «

Object File Directive ( H#xxfth#E4)
A A B H BRSSP D 38 4

Octal (J\#E#D
%7 0-7, UL 8 NS B SAAMALRR 1 MBS, AiAsE A Ron 8 MES, AlE=frFmr82=
64 MM, DL,
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Off-Chip Memory (5 5M7AESS)

JrhMEE R PICA8 51— MAF SRk 3, XA I FAEAE S T AL T B AR L, BRI R 5 A0 45 40 07 L2
fft. M Options>Development Mode CGEI>FH &AL 15 Memory %3+ 7 $T 7+ Off-Chip Memory Selection (J4h
PGSR XIEHE.

Opcode (#ERG)
BAE . 1§ WAL

Operator GZE%)
s “+” RS -7 RS, BEAEM T U IR XEHER . A EEFEMAE e kg, T e
SRAE FII -

OTP
Al —RfR. dEH D36 EPROM 2844, BT EPROM fFZ RSN R REFR AR A Z, B RA % H 2 v #
[Zih R

Pass Counter (X33
FR—AFE P AT E AR — 45164 RAEREE SR 1 5 . HIREGTH R A ER, T2 .
AL OB T B B A O 25 W A RN R B8 4, LAJRAE complex trigger (B Z&filiR ) SHEHE f AT AT BT B AT F A4k

PC
NN N SRR T

PC Host (PC FHL)
IBATSCHE Windows #:1E R4 44T PC.

Persistent Data (FAE¥03E)
FRANTE R BRI o AR FH A B H R 7 o] CATE #3F AL R A7 24 -

Phantom Byte (B#lF7)
dsPIC ZER AR SEIL T, 7RG 24 (484700 32 fifs &R . w35 HILTE dsPIC hex SCfFH

PIC MCU
PIC #5#H1L (MCU) #& Microchip i) AFE B A HLZ&F1 .

PICKkit™ 2 and 3 (PICkit 2 fl 3)
Microchip [T ket it Debug Express SKBUATIAE. 2T AN T HSCFFMBLLARtF, S WA TAK
ER A

Plug-in Gi&fth)
MPLAB IDE/MPLAB X IDE fiff F Py B 20 {F Fldi PR N 5 P PE RIS T R AL E R 48 AI{E Tools (T H) EHTH
FUAE T H .

Pod (ML)
LT E RIS . HAh GRS Puck CInHRANERBAD A Probe (RELZBHRERE) -

Power-on-Reset Emulation (_FREEAMFE)
FER TG i, BN S 280 RAM [X sttt RAM o (R 90 G40 AR B B A B B 72

Pragma (Pragma f§#4)
IR g VAR A = LMD HE 4 o I8 — 2% pragma P4 T T M g 1R 25 518 SR BLE LIS Be
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Precedence ({LZ2G)FF)
& SCRIE 3 SRAB W A )

Production Programmer (ZEf=4F252)

AR TESR R — Mg AE TR, HAERih T A SR AT PO MR TR . B R A TR R R TR T AR AR ) IR sE A
FFEdRFEINE . (EA IR, N BT EAHREE LRk, R EZER, B USA] Re ittt 28k gmfs 200
B,

Profile (F2Ex#)
XFF MPLAB SIM 3K 1E402%,  Z5 7788 AT R I R 51 3R .

Program Counter (F2FFit#i8%)
A IEAEPAT IR 2 [ Mk I AE A BTG

Program Counter Unit (F2F 382 84T)
16 (LI g e —— TR A A R MM SRR . W TEAMES T, B THEERREN 2. ErTHITERY, 2 MEFIT
M IS T 3 AN FAT. R EBh, 2 MR OCH S T 2 .

Program Memory (F2/57E0%88)
MPLAB IDE/MPLAB X IDE : 235718 S AT X o TRFE 05 FLAS BRI A% AL & TR 3% B 4w s [ 44 1 74
5 o

16 1077 i #/ 7iF 4% BB fe S A X .

Project (JiH)
T H L5 Y BE R 7 T I SO (URARRS AN BRI SO A48 , DARE AT & g 19 L B AN g BB T SCTHK

Prologue
G A A RS I — 7, ST ECHERR A ORAF A7 RS, DLRHATISAT I B rh i 58 AR AT LA s 52 T AL 3 ) 2
Ko BACRDAESE 52 B BT P AR 2 AT HRAT

Prototype System (F:HLR%)
6 FH P B9 B FR B BE FR AR BIARAE

Psect
GCC M1 OCG %&0E, program section (F2)FE) M4EE . BEEHA M — AR AT BB A B .

PWM Signal (PWM {55
Jik 78 EHIE 5. HLk PIC MCU &8 PWM 4hi% .

Qualifier (FRER)
VA S B T R, BRI B A Ak R b S — AR 2 BT R4

Radix (E¥0
B, FoNabfsRgl, AT e e — k.

RAM
BEHLUS A7t s (CBRAEAEaR) o AT BARME R Uy IR A7 fias o 4 B

Raw Data (JRZA#ER)
5—AEBUA RS sl ) i SRR .
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Read Only Memory ( RiEf7fikse)
EAEARTEAE, B ARVEPUE YT A H R AEAEREAR, B VR InEs o .

Real Time (3zB})

e LR AR a R R A N RS R, Ab A% DLt s s AT H S0 A I IE W e ) . ESemb iR, (HREDE
E AR PREE RN X, RS R B A, ERETE  B . AEER BRI N, b PR
WHztr, BEEA WS SSEE, s ER g ERT.

FEPAFRBIUAAE T, SEI OURIRA A HLIS 2 0T 5 0L CPU RTEILK 4 & 5 — FEER.

Recursive Call G£HEMA)
—ANE R AR E SR .

Recursion G#H)
EE X BB ERT AN E S . 295802 M ZR SN0 Z3 9% B O 5 S BN TRIEH .

Re-entrant (FTE A R#0)
A LT AN RIS AT (R S 1 BR 8. 78 R PR o0 R AT R ZE R AR N . BLEEBE B R s 8, B TE R s
B N PR AR T A P e A e PR AT I R

Relaxation C}&f#j)
B B — 48 S O T REAR B /NN IHE A R . X F 48 ALK AR A . MPLAB XC16 24 5if &nis an a4
CALL 184K v RCALL 54 . MMM 54T 4aT 5 2 1+/- 32k T8 2B AT, G SHAT%8AE .

Relocatable (F&Efr)
=R, B RIHHE A S B BT A R R k.

Relocatable Section (TJEENE)
16 L mas— bR e (a5t B, SEEEHET —ANFRON E AL I FE sk N ) & e i Be e stk

Relocation (FExEfr)
FERIRPAT I — NS, XA RE A, SRl E A B Ee gt ki, AT R A B O BT 455 R T T N S
i 8

ROM
Hgifeftids FEFPAFRESS) o AREBIURF -

Run (3Z1T)
B ELAR N RSB, SV BLARSER @ AT B FARAD . S e AR 1/O ARAS B SEI I B 1/O 4.

Run-time Model GZ/THMER)
IR H AR B IR 1

Run-time Watch GZ17H W)
Watches % 1, (A8 &0 N AR FIEATI k. Eafe i 3 Bis T meE, #62 WM THESCR. AR
FTE T RAR Y BT M

Scenario ()
MPLAB SIM AL, 35 F T 35042 il ) — i o 10 2

Section (B
OCG psect ] GCC L. PEEEAR N — AR P RY B el Fd e
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Section Attribute (BEE)
T-T B GCC %5t (Billn, access Bt

Sequenced Breakpoint (BT )
Y AE 5 B A LE I e B T A BRI T IR AT 3 s 3 R s G — AN e S AT

Serialized Quick Turn Programming (5% S HogEH#t &4 )
A AT LUK P 515 g AR B e g AR 2R AT AR A R LR . e S T AR IR R ARS . 08 ID 5.

Shell
MPASM 4w #s shell & 7L dnds MR . HHA MPASM JL4i#% shell: —AM4F%f DOS RAs, — ANt
Windows #1E RSt A

Simulator (BHE#IES)
B AR E AR T

Single Step (BB PAT)

X HB AT, —IRIAT— %%é WATHE %454 /5, MPLAB IDE/MPLAB X IDE T i 7 {788 % 1. Wis24p
w RS ER, AT Hr AR 4 mTﬁiﬁﬁcﬁéﬁﬁﬁ@,ﬁﬁ BRAT— 25484, MPLAB IDE/
MPLAB X IDE ¥#4T7—47=m 2% C i ﬁimm%ﬁmﬁ%

Skew

AN A H AR AL R A8 M E 5 PUTERIGE R Hilln, $ATHT— %58 2 fE h BUR T, AT IR
TR by SRR PAT IZERAEND I, YRR bk R A DA K H PR bk IRFE R4 b UPUT T —2% 1640, HFF
HPE IR S 2R b BREEG X — IR0 28 X5 8. Rk, BRERGIH X M — e o a8 =48 S MPUT
FR. PUT—F4BLAN, IN—FKE B35 —54E B E RN skew.

Skid
2 PR 7 OO B S Ab BRI, TEACER SR B IS AT T e HAT — K Z K484 . Wi B AT IR & 40Pk R skid.

Source Code (JEfLAY)
FWIEN R B ENEFRIER. RHEMERNREE SRR, TP 2 2 oRAE F $hAT .

Source File (JE3C4)
A, E PR ) ASCIH SCA S A

Special Function Register, SFR (J¥ZkIIRE A 4%)
HIRAF A% (RAMD [—85, LR TRH] V0 AFLaS ThEE. 1O RES . s i 2 s AR 3 K SMEE I 27 A7 o

sSQTP
S W75 G R 2 e

Stack, Hardware (3%, )
PIC . #LH 1R FH R B0 Al e bk iR A7 X

Stack, Software (#t%, #wfE)
AR L. RSB R A B . EE S A s BTN SISO N . BT E AR
PH .

Stack, Compiled (¥fk, SR¥F)
PRI E A A X, T RSO T ENZ N .. H7E B irasfd LIk s s A AR Y, i &
B HEH . ESFHIEE N,
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Static RAM or SRAM (#7 RAM Bk SRAM)
ERASBENLYT MAZERS . HASH T35 BASTE B4 H R AR P A7 2%

Status Bar CIREED)
IRESFAT MPLAB IDE/MPLAB X IDE & HERHES, feninyehnfi B RN a3 T B2 2 2RI 4 FiE
=]

JCh o

Step Into (BBHEN)
iX—#ir4 5 Single Step #[F. Step Into (5 Step Over M%) 7E CALL 4845, BB HAIT TIEF.

Step Over (BB

Step Over VFIRACHE I RS PAT TIEF . 24 step over —%& CALL 154N, F— /M A& ELE caLL 545
T—%4 4. mRBTEMER, FRFBEALRIGHNAEFRRE, F—MS s dr A28, BT caLs #
A abEE 4, Step Over iy 25 Single Step #H [

Step Out (HBBEH)
Step Out fF#& AT LABK tH YT IEAE AP BUT I TREF . 1 @ 2 PUTZ TR IR RS, SR 5 1% T2 IR [
BEAME (AT

Stimulus CEJFD
RABERLER SN (RIS A E015 5 A 2 T AR R ) o 38R B0 R SO St — R BIBERITE =R B
AU, FRPR (BIED BB R A AR -

Stopwatch (ffi3)
T EPAT B HAR T 5088

Storage Class (F#f&831)
11 78 548 T8 X GAH S BAT Al X A7 AR R 7] o

Storage Qualifier (FEAEFRERE)
BB BT O SRR ER JE A (U const) .

Symbol (%)

5 R H R A FEF A — M@ AL . X EIER AL . BES . BH . UL LRSI
PRIt 4%, MPLAB IDE/MPLAB X IDE H [ ff 5 EBIFTE X . ML girS . SE8E /5 MWEN 2 LA
R

Symbol, Absolute (%%, #xt)

SRR S AR s P R e ok, BN RS, B0, int scanMode  at (0x200) ;.
System Window Control (R4 H #44)

RYHE DA T & DAL HEAE R 2 L. Pz s S “Minimize” (/)
“Maximize” (& KAL) Fl “Close” (kM) TISEH.

Target (E#7)
faH

Target Application (BizNFRER)
B ARAR A
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Target Board ( H#7#%)
Fa R B AR S 0 LS AN AT S R 2R

Target Processor ( Hinib#5e)
b AR _E BB L

Template (AR
RCLEHEN B ORISR A A SCARAT . MPLAB g 88 4 AR AR A7 i B AR SCAEH

Toolbar (T.E4%)
— AT AN E bR, X S AR 01T MPLAB IDE/MPLAB X IDE &g .

Trace (JRER)
TORAE P PAT W B AR BRI SR T RE . 1 BB RR F SATIC B R BRI X, 1200 X P 2580 LA 3]
MPLAB IDE/MPLAB X IDE ] trace (¥REE) %1,

Trace Memory (BREZFEALIX)
IR X S B RSN TR IREAAFAE X A B RN ER BB M X o

Trace Macro (FREEZ)
— MBI RS R R IRE S B . T2 E T EIREE, AT e imBAS b AU B ek
POCAHS, I H s JUs A X H br s T A, 2 R EREEA 4 AR,

Trigger Output (filR%H#iH)
i A HE i AT AEAT R B O R R P AR ) 0 AR S S, SIRERAIWT S BB TOOG. AT BR EAT R A lUR S A

Trigraph (=FH/5)
SRS, #2293k, HISO C @ SUH TR MR

Unassigned Section (RAEER)
FEBERE B A SO R I RS 1 B FRAEA% X A B S 38 3R B A T 20 e R 20 E B B H AR AR A X

Uninitialized Data (GR¥JIE4EER)
TE SN R A EVIAE M EE . 7F C

int myVar;

5E ST RAT TR B R YR A B B — e i

Upload ( Ef%)
FAEThREB S N — AN TR G A sgm e 88D MLk ENHENL, SOREE M B bR A 1% 3005 8%

usB
WA ERAT R — P ANRANEEE CbRAE, T I 2 G A A XA SR AT A fa e TH S LR A A B TR BEAT i S . USB
1.0/1.1 32 12 Mbps 8L 4E % . USB 2.0 (BFRONRIE USB) SCiffkm 480 Mbps (4 (L 4k 5 .

Vector (HE)
S AL 8K T AR B N R e Bk A B B A i itk o

Volatile
— AR ERERF, R LA g 328 B 2 s i AR S AR AT A A 1 U 1) 5 s AL .
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Warning (&%)
MPLAB IDE/MPLAB X IDE: $#REEHIL T ATRE S EARLE . B SCAF & A Y E R R i i 4

16 (7] i/ i a5 - B 5 A5 W REAFAE A 2% AF, (EIF AT AL EE,

Watch Variable (JLE2258)
PR 215 A 7 7F Watches % 119 s 35 A0 &

Watches Window (Watches & 1)
Watches & & — RAIMEEA T, X E0AF B AE R R IAT 2 W w58 5 .

Watchdog Timer, WDT (& JfEm 5
PIC B 5 L 7E — Bl 3K B B 8] 5 R A AR ER S e i 8 o (AR ELALORAERE . 2210 A1 E WDT.

Workbook (T{E#)
¥+ MPLAB SIM #5425, & —FiH 774 SCL il E
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© PRIRER—HETF AR R . NAZICAURBIRET . BRI B R R AR SCRESCRY . SO R AR R i
ENVYSEEVEL ¢ts
o —RBRERIRE—F WHERE (FAQ) « BARIREER. LT84 LK Microchip BEiH 4k R Rk 52 44 B
Microchip W &—— Sk B AT ISR . &8 Microchip #rlEHa. WIS SAES)2HE# . Microchip 45 /55
Ab. AREERLLE T REFIF

772 it 2 B I S AR 5

Microchip {7 i A2 S A1 55 A B 1% 77 T Microchip 7 fh O 5cBH 5 B o FEMPE Al AR AT IO ER IR 2E AN il 2 571
BT R TRRAASE . B RATHT AR SRR, ] R .

BRVEME, %5 R www.microchip.com/pen, SR JEFIR R B BE T ERAE .

- IRb &)

Microchip 7= fh i F el gk DL S5 3R A5 45 B :

< RHEREE

b I AL

« MHIFNM (ESE)

o HIRIHE
PR R AR . AR ESE FoRSCHFE. HHE B F AR PRI B . A R A E S F AR
77 e
W AT 3@ E www.microchip.com/support 3545 _E AR Sk,

Microchip 23ISR ThEE

157E 7 LR A 5% Microchip 77 S AT AR T RE Y B 45
Microchip 177 1134 2] Microchip HiE - Brd R BT .
Microchip #if5: TEIEH M@ H B TAEMIEHIEGL T, Microchip &7 AEH %4,
* Microchip 73 # I FRARS H AR B P2 AR E R Microchip 7 S ABBIRIF TIREIAT v, IXFMT NATRES:
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Microchip BATAT HAth 2 G4 ) 35 o2 RAiE FLARRE ) 22 Ak o ARRGARAP AR R oA TORAIE = S “ 2R ml Al
1. FREDfRIPThEeAb T3 R . Microchip 24K v AN W ot = i AR HD AR 4 Th g

B

FRAEA SRS SCRRAA Dy T8 T EEAR . 15 270 2R SCR AL S SR 4, R R T 75 9% Microchip 7= & B AN
{FH B M EIHE 1SS . Microchip Technology Inc. X H AR MR AE . FHEE S R T RFSRIEYLXT BT
REATAE ATAT Z 45 A AR IBAEAT 5T . 2% Microchip Technology Inc. (I3 SRR SCRY «

A R B F AR A4 BAUE AT Microchip 728, AE R TE MR BLK ¥4 Microchip 7= SR BRI H . AL A
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MPASM. MPF. MPLAB Certified 45+ MPLIB. MPLINK. MultiTRAK. NetDetach. NVM Express. NVMe.
Omniscient Code Generation. PICDEM. PICDEM.net. PICkit. PICtail. PowerSmart. PureSilicon. QMatrix.
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Technology Inc. 73 [ 41 52 B IX v A -
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Hif: 480-792-7200
fE ¥ 480-792-7277
BORSFf

www.microchip.com/support

’)(—xJiJJ:Z
www.microchip.com
MHREZR

T, VEREN
Miifi: 678-957-9614
1£3: 678-957-1455
BYNT, EEEHM
Hif: 512-257-3370
W

TR, SEEEIEMN
HiE: 774-760-0087
fE¥: 774-760-0088
Z g

IR, R
Hi5: 630-285-0071
f£H: 630-285-0075
LR}

R, FETEEEHTM
HiiE: 972-818-7423
L H: 972-818-2924
JRRERR

A, 2 BRI
Hi%: 248-848-4000
RHT, FETLBEHN
HiE: 281-894-5983
S8 YRR

VAR R, ENES N

HiiF: 317-773-8323
tEH.: 317-773-5453
H1if: 317-536-2380
b2 2

KGR, InFAE e T
H1i%: 949-462-9523
f£H: 949-462-9608
H1i%: 951-273-7800
FH), dRTRMM
H1if: 919-844-7510
a4, ALM

H1if: 631-435-6000
EME, IRAERBEM
H1i%: 408-735-9110
Hif: 408-436-4270
ngEX - 2486%

H1if: 905-695-1980
f£F: 905-695-2078

WRAE - BB

iE: 61-2-9868-6733
HE -4t

% 86-10-8569-7000
HE - B

if: 86-28-8665-5511
HHE - ER

Hif: 86-23-8980-9588
FHE - R

Hif: 86-769-8702-9880
HE -

Hii%: 86-20-8755-8029
HE - B

Hii%: 86-571-8792-8115
HHE - FEBRRATBEX
HiE: 852-2943-5100
HE - FR

if: 86-25-8473-2460
HHE-FE

i 86-532-8502-7355
FHE - L

Hif: 86-21-3326-8000
HHE - YR

HiiE: 86-24-2334-2829
HHE - H

Hii%: 86-755-8864-2200
HHE - M

% 86-186-6233-1526
HE - BR

i 86-27-5980-5300
HE - AR

if: 86-20-8833-7252
HHE - K]

i 86-592-2388138
HHE - 2R

Hii%: 86-756-3210040
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BN - BEIP R

HiiE: 91-80-3090-4444
BB - B e

HiF: 91-11-4160-8631
210 F:

HiF: 91-20-4121-0141
HZ - KB

Hif: 81-6-6152-7160
HA& - R

Hif: 81-3-6880-3770
5N

HiE: 82-53-744-4301
HHE - E5K
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ORFGW. - FHEY,

HiiE: 60-3-7651-7906
TR, - 4ARIS
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R - Deh
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Frindg

Hif: 65-6334-8870
EEHIX - FiT

Hif: 886-3-577-8366
ERHX - Fkk

HiiE: 886-7-213-7830
HEHKX - Gk

HiiE: 886-2-2508-8600
=H-2%8

% 66-2-694-1351
#E - BT

Hif: 84-28-5448-2100

VAt =17

B - SR

H1iE: 43-7242-2244-39
fEH: 43-7242-2244-393
& - AR

Hiif: 45-4485-5910
fEH.: 45-4485-2829
32 - RETR

H1if: 358-9-4520-820
YE-BR

H1if: 33-1-69-53-63-20
fEH: 33-1-69-30-90-79
RE - Iy

H1if: 49-8931-9700
EE - R

H1if: 49-2129-3766400
PR - ¥g/RATE

Hiif: 49-7131-72400
BE - RRTEE

Hii%: 49-721-625370
BE - FeE

H1i%: 49-89-627-144-0
fEH: 49-89-627-144-44
EE - BREE

Hii%: 49-8031-354-560
M-S - BRI

H1if: 972-9-744-7705
BRA - K=

H1i%: 39-0331-742611
f£#: 39-0331-466781
BRA - HE R

H1if: 39-049-7625286
i - ST

H1i%: 31-416-690399
fEH: 31-416-690340
HRBR - REREHRI

Hiifi: 47-72884388

W= - Y

Hii%: 48-22-3325737
DL - e
H1i%: 40-21-407-87-50
BT - R

H1i: 34-91-708-08-90
fE#: 34-91-708-08-91
Hige - AL

H1i%: 46-31-704-60-40
Fidh - BEE R EE
H1if: 46-8-5090-4654
®E - R&BE

H1i%: 44-118-921-5800
tEH: 44-118-921-5820
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